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� 讲述 90分钟

� 休息 20 分钟

� 2 个实验 60 分钟

� 休息 60 分钟

� 10
� 4个实验 2 小时

� 休息 20 分钟

�� 讲述讲述 9090分钟分钟

�� 休息休息 20 20 分钟分钟

�� 2 2 个实验个实验 60 60 分钟分钟

�� 休息休息 60 60 分钟分钟

�� 1010
�� 44个实验个实验 2 2 小时小时

�� 休息休息 20 20 分钟分钟

日程日程日程

讲述 部分讲述讲述 部分部分

实验部分1实验部分实验部分11

实验部分2实验部分实验部分22
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� 架构

� 存储器

� 指令集

� 开发软件 (MPLAB® IDE)

�� 架构架构

�� 存储器存储器

�� 指令集指令集

�� 开发软件开发软件 ((MPLABMPLAB®® IDE)IDE)

讲述部分的内容讲述部分的内容讲述部分的内容
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� Labs
� 在 MPLAB IDE创建项目

� 调试和跳转控制

� PWM
� A/D 
� 中断

� 演示 (时间允许的话)
� PIC16F877A实现多任务

�� LabsLabs
�� 在在 MPLAB IDEMPLAB IDE创建项目创建项目

�� 调试和跳转控制调试和跳转控制

�� PWMPWM
�� A/D A/D 
�� 中断中断

�� 演示演示 ((时间允许的话时间允许的话))
�� PIC16F877APIC16F877A实现实现多任务多任务

实验和演示部分的内容实验和演示部分的内容实验和演示部分的内容
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架构架构架构
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Microchip PIC® MCU 金字塔Microchip PICMicrochip PIC®® MCU MCU 金金字塔字塔

PIC16C5X
PIC12C5XX
PIC16C5XPIC16C5X

PIC12C5XXPIC12C5XX

PIC16
PIC12F
PIC16PIC16

PIC12FPIC12F

PIC18PIC18PIC18

dsPICdsPICdsPIC

14 bits14 bits

16 bits16 bits

24 bits24 bits

12 bits12 bits

8 bit8 bit
MCUMCU

16 bit16 bit
MCUMCU

程序存储器

宽度

程序存储器程序存储器

宽度宽度

数据存储器

宽度

数据存储器数据存储器

宽度宽度
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PICmicro Architecture
RISC-like Features

PICmicro ArchitecturePICmicro Architecture
RISCRISC--like Featureslike Features

� 内部为哈佛结构

� 寄存器文档

� 大多数单指令周期

�� 内部为哈佛结构内部为哈佛结构

�� 寄存器文档寄存器文档

�� 大多数单指令周期大多数单指令周期

� 指令流水线操作

� 长字型指令

� 指令数很少

� 指令实现的功能基本不重复

�� 指令流水线操作指令流水线操作

�� 长字型指令长字型指令

�� 指令数很少指令数很少

�� 指令实现的功能基本不重复指令实现的功能基本不重复

PIC单片机之所以有很高的性能是因为其具备如下特
性:
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PIC单片机架构
哈佛结构

PICPIC单片机架构单片机架构
哈佛哈佛结构结构

� 从同一存储器空间取指令
和取操作数据.
� 限制了数据流量

�� 从同一存储器空间取指令从同一存储器空间取指令
和取操作数据和取操作数据..
�� 限制了数据流量限制了数据流量

程序和程序和
数据数据
存储器存储器

冯冯--纽曼结构纽曼结构

88--位位

CPUCPU

程序程序
存储器存储器

数据数据
存储器存储器

88--位位

12/14/1612/14/16--位位

哈佛结构哈佛结构

CPUCPU

从两个独立的存储空间分别取
指令和存取操作数.

数据流量增加
针对程序区和数据区可以设计
不同的数据线宽度

从两个独立的存储空间分别取
指令和存取操作数.

数据流量增加
针对程序区和数据区可以设计
不同的数据线宽度
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Flush FetchFlush Fetch 44
Fetch SUB_1Fetch SUB_1

� 大部分单片机, 其取指和执行过程是顺序进行的.
� 指令流水线的引入允许取指和执行可以同步进行.
� 使得指令可以在一个指令周期内执行.
� 程序分支例外 (如 GOTO, CALL 或直接修改PC)，
这需两个指令周期.

Tcy0    Tcy1    Tcy2    Tcy3    Tcy4

�� 大部分单片机大部分单片机, , 其取指和执行过程是顺序进行的其取指和执行过程是顺序进行的..
�� 指令流水线的引入允许取指和执行可以同步进行指令流水线的引入允许取指和执行可以同步进行..
�� 使得指令可以在一个指令周期内执行使得指令可以在一个指令周期内执行..
�� 程序分支例外程序分支例外 ((如如 GOTO, CALL GOTO, CALL 或直接修改或直接修改PC)PC)，，
这需两个指令周期这需两个指令周期..

Tcy0    Tcy1    Tcy2    Tcy3    Tcy4Tcy0    Tcy1    Tcy2    Tcy3    Tcy4

PIC单片机架构
指令流水线

PICPIC单片机架构单片机架构
指令流水线指令流水线

Execute 1Execute 1

Fetch 3Fetch 3

1. 1. MOVLW 55hMOVLW 55h Fetch 1Fetch 1

Execute 3Execute 3
Fetch 2Fetch 2 Execute 2Execute 2

Fetch 4Fetch 4

2. 2. MOVWF  PORTBMOVWF  PORTB
3. 3. CALL SUB_1CALL SUB_1
4. 4. BSF PORTA, BIT3BSF PORTA, BIT3
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PIC单片机架构
寄存器文档概念

PICPIC单片机架构单片机架构
寄存器文档概念寄存器文档概念

General PurposeGeneral Purpose
Registers (RAM)Registers (RAM)

Other Other SFRsSFRs
PORTAPORTA

FSRFSR
STATUSSTATUS

PCLPCL
TMR0TMR0
INDFINDF

W RegisterW Register

ALUALU

数据数据
存储器存储器

直接数据地址直接数据地址 <7><7>操作码操作码 <7><7>
1414--位字长的指令范例位字长的指令范例::

�� RAMRAM被看作是一组通用被看作是一组通用

的寄存器的寄存器..
�� 周边模块周边模块((I/O)I/O)也作为寄也作为寄
存器存器..
�� 所有的指令操作都可针所有的指令操作都可针
对所有的寄存器对所有的寄存器..
�� 长字指令使得在指令中长字指令使得在指令中

直接寻址寄存器直接寻址寄存器..
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PICmicro 架构
指令实例

PICmicro 架构
指令实例

� PIC MCU 指令编码为操作码和参数

� 编码用一个字完成

� PIC MCU 指令编码为操作码和参数

� 编码用一个字完成

OP CODEOP CODE kk

立即数类指令立即数类指令

kk kk kk kk kk kk kk
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PIC MCU 晶振PIC MCU PIC MCU 晶振晶振

PIC MCUPIC MCU

4 MHz
(250 ns)
4 4 MHzMHz
(250 ns)(250 ns)

1 MHz 
(1 us)

1 1 MHz MHz 
(1 us)(1 us)

foscfosc

TcyTcy

� 指令率是输入时
钟的 1/4 

� 输入晶振频率叫
做fosc

� 一个指令周期占
用 1 Tcy

�� 指令率是输入时指令率是输入时
钟的钟的 1/4 1/4 

�� 输入晶振频率叫输入晶振频率叫
做做ffoscosc

�� 一个指令周期占一个指令周期占
用用 1 1 TTcycy
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存储器存储器
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PICmicro 架构
存储器

PICmicro PICmicro 架构架构
存储器存储器

� 两种类型
� 程序

� (RAM 和EEPROM)

� 组成
� Pages - 页 (程序存储器)
� Banks – 组 (数据存储器) 

�� 两种类型两种类型
�� 程序程序

�� ((RAM RAM 和和EEPROM)EEPROM)

�� 组成组成
�� Pages Pages -- 页页 ((程序程序存储器存储器))
�� Banks Banks –– 组组 ((数据数据存储器存储器) ) 
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PICmicro架构
存储器表

PICmicroPICmicro架构架构
存储器表存储器表

FLASH
程序程序存储器存储器

RAM
数据数据存储器存储器

大小 (words) GPR 大小 (bytes)

1 K 64PIC12F675

PIC16F877A 8 K 368

PICmicro MCU
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分页的程序存储器
(14bit 核)

分页的分页的程序程序存储器存储器
(14bit (14bit 核核))

OP CODEOP CODE kk kk kk kk kk kk kk kk kk kk kk
CALL or GOTO instructionCALL or GOTO instructionCALL or GOTO instruction

3 bits for 
instruction
3 3 bits for bits for 

instructioninstruction
11 bits for 
destination
11 11 bits for bits for 
destinationdestination

� 在14-bit 核的器件中:
� 11 位访问 211 或 2048 (2k) 空间

� 访问更多的空间,需要更多的位

� 程序存储器的分页提供这些位

�� 在在1414--bit bit 核的器件中核的器件中::
�� 11 11 位访问位访问 221111 或或 2048 (2k) 2048 (2k) 空间空间

�� 访问更多的空间访问更多的空间,,需要更多的位需要更多的位

�� 程序程序存储器的分页提供这些位存储器的分页提供这些位
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14-bit 核架构
程序存储器

1414--bit bit 核架构核架构
程序程序存储器存储器

� 程序存储器最大8K字
� 四页,每页 2k 
� 使用 PCLATH<4:3>访

问页

� 复位地址 0000h
� 中断地址 0004h

�� 程序程序存储器最大存储器最大8K8K字字

�� 四页四页,,每页每页 2k 2k 
�� 使用使用 PCLATH<4:3>PCLATH<4:3>访访

问页问页

�� 复位地址复位地址 00000000hh
�� 中断地址中断地址 00040004hh

Page 0Page 0

00000000hh

00040004hh

0707FFhFFh

InterruptInterrupt

ResetReset

Page 1Page 1

08000800hh

00FFFhFFFh

Page 2Page 2

10001000hh

1717FFhFFh

Page 3Page 3

18001800hh

11FFFhFFFh

PCLATH<4:3> = 00PCLATH<4:3> = 00

PCLATH<4:3> = 01PCLATH<4:3> = 01

PCLATH<4:3> = 10PCLATH<4:3> = 10

PCLATH<4:3> = 11PCLATH<4:3> = 11
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PICmicro架构
程序存储器: PC绝对寻址

PICmicro架构架构
程序程序存储器存储器: PCPC绝对寻址绝对寻址

OP CODEOP CODE kk kk kk kk

1414--bit Instruction for call and bit Instruction for call and gotogoto

kk kk kk kk kk kk kk

用CALL和GOTO指令修改PC 用用CALLCALL和和GOTOGOTO指令指令修改PC 

kk kk kk kk kk kk kk kk kk

xx xx xx kk kk xx xx xx

PCLATH RegisterPCLATH Register

有效的有效的 1313--bitbit程序程序存储器地址存储器地址

1111--bits From Instructionbits From Instruction
22--bits bits 
FromFrom
PCLATHPCLATH

kk kk kk kk
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PICmicro架构
分页的程序存储器

PICmicro架构架构
分页的分页的程序程序存储器存储器

� 当执行CALL or GOTO 指令时,需考虑分页

� 当跳转到不同的页时,修改页位

� 调用页位:
– GOTO <地址>
– CALL <地址>
– <Instruction> PCL,F ; e.g.  ADDWF   PCL,F

� 返回时不需考虑页

�� 当执行当执行CALL or GOTO CALL or GOTO 指令时指令时,,需考虑分页需考虑分页

�� 当跳转到不同的页时当跳转到不同的页时,,修改页位修改页位

�� 调用页位调用页位::
–– GOTO GOTO <<地址地址>>
–– CALL CALL <<地址地址>>
–– <Instruction> PCL,F<Instruction> PCL,F ; e.g.  ADDWF   PCL,F; e.g.  ADDWF   PCL,F

�� 返回时不需考虑页返回时不需考虑页
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PICmicro 架构
PC 相对寻址 (14-bit core)

PICmicro 架构
PCPC 相对寻址 (14-bit core)

PCH <5>PCH <5> PCL <8>PCL <8>

1313--Bit Program CounterBit Program Counter

PCLATH <5>PCLATH <5>

Internal Data Bus <8>Internal Data Bus <8>

55

55

88

�� 高字节写入高字节写入PCLATH.PCLATH.
�� 然后低字节写入然后低字节写入 PCL, PCL, 将装入将装入1313--bit bit 值到值到 PC.PC.

movlwmovlw HIGH DelayHIGH Delay
movwfmovwf PCLATHPCLATH
movlwmovlw LOW DelayLOW Delay
movwfmovwf PCLPCL

Note: Note: PCHPCH cannot be readcannot be read
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分组的 数据存储器
(14 bit core)

分组的分组的 数据存储器存储器
(14 bit core)(14 bit core)

Data Modifying InstructionData Modifying InstructionData Modifying Instruction

7位指令编码77位指令编码位指令编码 7位目标地址77位目标地址位目标地址

� 在14-bit 核的器件中:
� 7 位访问 27 或 128 空间

� 访问更多的空间,需要更多的位

� 程序存储器的分组提供这些位

�� 在在1414--bit bit 核的器件中核的器件中::
�� 7 7 位访问位访问 2277 或或 128 128 空间空间

�� 访问更多的空间访问更多的空间,,需要更多的位需要更多的位

�� 程序程序存储器的分组提供这些位存储器的分组提供这些位

OP CODEOP CODE ff ff ff ff ff ff ff
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PICmicro 架构
数据存储器: 直接寻址

PICmicro PICmicro 架构架构
数据存储器存储器: : 直接寻址直接寻址

� 低7位的数据地址直接在指令中描述

� 高2位在STATUS寄存器中 (又称寄存器组号BANK)
�� 低低77位的数据地址直接在指令中描述位的数据地址直接在指令中描述

�� 高高22位在位在STATUSSTATUS寄存器中寄存器中 ((又称寄存器组号又称寄存器组号BANK)BANK)

指向目标寄存器的指向目标寄存器的99位有效地址位有效地址

IRPIRP RP1RP1RP0RP0 OP CODEOP CODETOTO PDPD ZZ DCDC CC

STATUSSTATUS寄存器寄存器 1414位长指令位长指令

ff ff ff ff ff ff ff

RP1RP1 RP0RP0 ff ff ff ff ff ff ff

77位来自指令位来自指令

22位来自位来自
STATUSSTATUS
寄存器寄存器
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PICmicro 架构
数据存储器组成

PICmicro PICmicro 架构架构
数据存储器组成存储器组成

� 分成4个组

� SFR映射到最顶端
32 位置

� 通过RP0,1 和 IRP 
选择组

�� 分成分成44个组个组

�� SFRSFR映射到最顶端映射到最顶端
32 32 位置位置

�� 通过通过RP0,1 RP0,1 和和 IRP IRP 
选择组选择组

GPRsGPRs

SFRsSFRs

Bank0Bank0

000000hh

0101FhFh
020020hh

0707FhFh

GPRsGPRs

SFRsSFRs

Bank1Bank1

080080hh

0909FhFh
00A0hA0h

00FFhFFh
00F0hF0h

GPRsGPRs

SFRsSFRs

Bank2Bank2

100100hh

1111FhFh
120120hh

1717FhFh
170170hh

GPRsGPRs

SFRsSFRs

Bank3Bank3

180180hh

1919FhFh
11A0hA0h

11FFhFFh
11F0hF0h

RP<1:0>               RP<1:0>               RP<1:0>             RP<1:0>               RP<1:0>               RP<1:0>             RP<1:0>RP<1:0>
= 00                      = 01                      = 10     = 00                      = 01                      = 10     = 11= 11
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File Address 
(hex)

Bank 0

Unimplemented data memory location; read as '0'.

寄存器图寄存器图
PIC12F675PIC12F675

PICmicro 架构
数据存储器

PICmicro PICmicro 架构架构
数据存储器存储器

PCLATH PCLATH
INTCON INTCON

FSR FSR
GPIO TRISIO

PCL PCL
STATUS STATUS

Indirect addr. (1) Indirect addr. (1)

TMR0 OPTION_REG
02
03

00
01

04
05

0A
0B

PIE10C PIR1
0D

PCON0E TMR1L
TMR1H0F

OSCCAL10 T1CON

WPU15
IOC16

CMCON VRCON
EEDATA

19
1A

EEADR1B
EECON11C

EECON2(1)1D
ADRESH ADRESL1E

ANSEL1F ADCON0

82
83

80
81

84
85

8A
8B
8C
8D
8E
8F
90

95
96

99
9A
9B
9C
9D
9E
9F

File Address 
(hex)

Bank 1

General 
Purpose
Registers
(64 Bytes)

accesses
20h-5Fh

A0

DF

20

5F

Special Function Registers (SFR).
General Purpose Registers (GPR), user RAM.
Not a Physical Register.1
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0000000000000000XXXXXXXXXXXXXXXX

PICmicro MCU架构
PC相对寻址

PICmicro MCU架构
PC相对寻址

� 实现查找表范例� 实现查找表范例movlwmovlw HIGH DecodeHIGH Decode
movwfmovwf PCLATHPCLATH
movfmovf DisplayValue,WDisplayValue,W
callcall DecodeDecode
movwfmovwf PORTBPORTB
gotogoto ContinueContinue

DecodeDecode
addwfaddwf PCL,FPCL,F
retlwretlw BB’’0011111100111111’’ ;decode 0;decode 0
retlwretlw BB’’0000011000000110’’ ;decode 1;decode 1
retlwretlw BB’’0101101101011011’’ ;decode 2;decode 2
retlwretlw BB’’0100111101001111’’ ;decode 3;decode 3
retlwretlw BB’’0110011001100110’’ ;decode 4;decode 4
retlwretlw BB’’0110110101101101’’ ;decode 5;decode 5
retlwretlw BB’’0111110101111101’’ ;decode 6;decode 6
retlwretlw BB’’0000011100000111’’ ;decode 7;decode 7
retlwretlw BB’’0111111101111111’’ ;decode 8;decode 8
retlwretlw BB’’0110111101101111’’ ;decode 9;decode 9

ContinueContinue

bb

ee

RB0
RB1
RB2

RB3
RB4
RB5

RB6

b
c

d
e
f
g

W RegisterW Register I/O Port BI/O Port B
011011010110110100000101 00000101 

movfmovf DisplayValue,WDisplayValue,W
callcall DecodeDecode

addwfaddwf PCL,FPCL,F

retlwretlw BB’’0110110101101101’’ ;decode 5;decode 5

movwfmovwf PORTBPORTB

01101101 01101101 

gg

aa

ff

dd

cc

gg

aa

ff

dd

cc

bb

ee

a
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IRPIRP ff ff ff ff ff ff ff ff

ff

PICmicro架构
间接寻址

PICmicroPICmicro架构
间接寻址

� 用FSR寄存器作为8位地址指针

� 另外1位在STATUS中描述

�� 用用FSRFSR寄存器作为寄存器作为88位地址指针位地址指针

�� 另外另外11位在位在STATUSSTATUS中描述中描述

IRPIRP RP1RP1 RP0RP0 TOTO PDPD ZZ DCDC CC ff ff ff ff ff ff ff

STATUS STATUS 寄存器寄存器rr 88位位 FSR FSR 寄存器寄存器

有效的有效的 99位地址位地址

88位来自位来自FSRFSR

1 1 位来自位来自

STATUSSTATUS
寄存器寄存器
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PICmicro架构
间接寻址

PICmicroPICmicro架构
间接寻址

� FSR 和 INDF 用于间接寻址

� FSR 是地址指针

� INDF 保存移动的值

�� FSR FSR 和和 INDF INDF 用于用于间接寻址

�� FSRFSR 是地址指针是地址指针

�� INDFINDF 保存移动的值保存移动的值

55

2222
FSR

INDF

Writing Reading

55
21
22
23
24

55

2222
FSR

INDF

55
21
22
23
24

movlw 22
movwf FSR
movlw 5
movwf INDF

movlw 22
movwf FSR
movf INDF,W
movwf 5
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PICmicro架构
间接寻址

PICmicroPICmicro架构
间接寻址

� 清除 0x20 to 0x7F的RAM.� 清除 0x20 to 0x7F的RAM.

movlwmovlw 0x200x20
movwfmovwf FSRFSR

LOOPLOOP clrfclrf INDFINDF
incfincf FSR,FFSR,F
btfssbtfss FSR,7FSR,7
gotogoto LOOPLOOP
<next instruction><next instruction>

0000 00000000 0000

0000 00000000 0000

FSR = 20hFSR = 20h

INDFINDF0000hh

0404hh

2020hh

77FhFh

Data MemoryData Memory
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指令系统指令系统指令系统



© Microchip Technology Incorporated. All Rights Reserved.         701 PIC           701 PIC           PIC® MCU - Introduction to Programming          30

PICmicro MCU 指令集
(14-bit core)

PICmicro MCU PICmicro MCU 指令集指令集
(14(14--bit core)bit core)

� 35 条指令

� 易学

� 紧凑

� 单字指令

� 向上兼容

�� 35 35 条指令条指令

�� 易学易学

�� 紧凑紧凑

�� 单字指令单字指令

�� 向上兼容向上兼容
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PICmicro指令集PICmicro指令集指令集

1414位内核之字节操作指令构成位内核之字节操作指令构成

OP CODEOP CODE dd ff ff ff ff ff ff ff

d = Destination Bitd = Destination Bit
d = 0 for destination Wd = 0 for destination W
d = 1 for destination Fd = 1 for destination F

f = 7f = 7--bit Register Addressbit Register Address

Example:Example:
ADDWF   ADDWF   REG, WREG, W
ADDWFADDWF f, df, d

NOPNOP --
MOVWFMOVWF ff
CLRWCLRW --
CLRFCLRF ff
SUBWFSUBWF f,df,d
DECFDECF f,df,d
IORWFIORWF f,df,d
ANDWFANDWF f,df,d
XORWFXORWF f,df,d
ADDWFADDWF f,df,d
MOVFMOVF f,df,d
COMFCOMF f,df,d
INCFINCF f,df,d
DECFSZDECFSZ f,df,d
RRFRRF f,df,d
RLFRLF f,df,d
SWAPFSWAPF f,df,d
INCFSZINCFSZ f,df,d

字节操作
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1122

11

移动数据: 立即数, W and F移动数据移动数据: : 立即数立即数, W and F, W and F

MyVar

movfmovf MyVar,WMyVar,W

incfincf MyVar,FMyVar,F

W or WREG

File Registers

movwfmovwf MyVarMyVar

22

111

立即数

movlwmovlw 11
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PICmicro指令集
汇总

PICmicro指令集
汇总

ADDWFADDWF f,df,d Add W and fAdd W and f
ANDWFANDWF f,df,d AND W and fAND W and f
CLRFCLRF ff Clear fClear f
CLRWCLRW -- Clear WClear W
COMFCOMF f,df,d Complement fComplement f
DECFDECF f,df,d Decrement fDecrement f
DECFSZDECFSZ f,df,d Decrement f, skip if zeroDecrement f, skip if zero
INCFINCF f,df,d Increment fIncrement f
INCFSZINCFSZ f,df,d Increment f, skip if zeroIncrement f, skip if zero
IORWFIORWF f,df,d Inclusive OR W and fInclusive OR W and f
MOVFMOVF f,df,d Move fMove f
MOVWFMOVWF ff Move W to fMove W to f
NOPNOP -- No OperationNo Operation
RRFRRF f,df,d Rotate right f through carryRotate right f through carry
RLFRLF f,df,d Rotate left f through carryRotate left f through carry
SUBWFSUBWF f,df,d Subtract W from fSubtract W from f
SWAPFSWAPF f,df,d Swap nibbles of fSwap nibbles of f
XORWFXORWF f,df,d Exclusive OR W and fExclusive OR W and f

BCFBCF f,bf,b Bit clear fBit clear f
BSFBSF f,bf,b Bit set fBit set f
BTFSCBTFSC f,bf,b Bit test f, skip if clearBit test f, skip if clear
BTFSSBTFSS f,bf,b Bit test f, skip if setBit test f, skip if set

SLEEPSLEEP -- Go into standby modeGo into standby mode
CLRWDTCLRWDT -- Clear watchdog timerClear watchdog timer
RETLWRETLW kk Return, place literal in WReturn, place literal in W
RETFIERETFIE -- Return from interruptReturn from interrupt
RETURNRETURN -- Return from subroutineReturn from subroutine
CALLCALL kk Call subroutineCall subroutine
GOTOGOTO kk Go to address (k is 9Go to address (k is 9--bit)bit)
MOVLWMOVLW kk Move literal to WMove literal to W
IORLWIORLW kk Inclusive OR literal with WInclusive OR literal with W
ADDLWADDLW kk Add literal with WAdd literal with W
SUBLWSUBLW kk Subtract W from literalSubtract W from literal
ANDLWANDLW kk AND literal with WAND literal with W
XORLWXORLW kk Exclusive OR literal with WExclusive OR literal with W

ByteByte--Oriented OperationsOriented Operations BitBit--Oriented OperationsOriented Operations

Literal and Control OperationsLiteral and Control Operations

f = File Register, k = literal value (8-bit), b = bit address <0 to 7>, d = destination (W or file register)



© Microchip Technology Incorporated. All Rights Reserved.         701 PIC           701 PIC           PIC® MCU - Introduction to Programming          34

PICmicro指令集
位操作

PICmicro指令集
位操作

1414位内核之位操作指令构成位内核之位操作指令构成

OP CODEOP CODE bb ff ff ff ff ff ff ff

b = 3b = 3--Bit AddressBit Address
(Bit Number)(Bit Number)

f = 7f = 7--bit Register Addressbit Register Address

bb bb

例例::
BTFSCBTFSC STATUS, CSTATUS, C
BTFSCBTFSC f, bf, b

BCFBCF f,bf,b
BSFBSF f,bf,b
BTFSCBTFSC f,bf,b
BTFSSBTFSS f,bf,b

位操作

0000 00000000 00000000 0000

Bit 7Bit 7Bit 7 Bit 0Bit 0Bit 0
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PICmicro指令集
立即数和控制操作

PICmicro指令集
立即数和控制操作

kk

1414位内核之立即数和控制指令构成位内核之立即数和控制指令构成

OP CODEOP CODE kk kk kk kk kk kk kk

k = 8k = 8--bit Immediate Valuebit Immediate Value

例例::
MOVLWMOVLW 0x2F0x2F
MOVLWMOVLW kk

SLEEPSLEEP --
CLRWDTCLRWDT --
RETLWRETLW kk
RETFIERETFIE --
RETURNRETURN --
CALLCALL kk
GOTOGOTO kk
MOVLWMOVLW kk
IORLWIORLW kk
ADDLWADDLW kk
SUBLWSUBLW kk
ANDLWANDLW kk
XORLWXORLW kk

立即数和控制操作
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14-bit单片机指令集
操作实例

14-bit单片机指令集
操作实例

NOP No Operation
Syntax: NOP
Operands: None
Operation: No operation
Status: None
Encoding: 00 0000 0000 0000
Words: 1
Cycles: 1

NOPNOP No OperationNo Operation
Syntax:Syntax: NOPNOP
Operands:Operands: NoneNone
Operation:Operation: No operationNo operation
Status:Status: NoneNone
Encoding:Encoding: 00 0000 00 0000 00000000 00000000
Words:Words: 11
Cycles:Cycles: 11

� 例:
NOP

�� 例例::
NOPNOP
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14-bit 核指令集
字节操作

14-bit 核指令集
字节操作

1414位内核之字节操作指令构成位内核之字节操作指令构成

OP CODEOP CODE dd ff ff ff ff ff ff ff

d = Destination Bitd = Destination Bit
d = 0 for destination Wd = 0 for destination W
d = 1 for destination Fd = 1 for destination F

f = 7f = 7--bit Register Addressbit Register Address

Example:Example:
ADDWF   ADDWF   REG, WREG, W
ADDWFADDWF f, df, d

NOPNOP --
MOVWFMOVWF ff
CLRWCLRW --
CLRFCLRF ff
SUBWFSUBWF f,df,d
DECFDECF f,df,d
IORWFIORWF f,df,d
ANDWFANDWF f,df,d
XORWFXORWF f,df,d
ADDWFADDWF f,df,d
MOVFMOVF f,df,d
COMFCOMF f,df,d
INCFINCF f,df,d
DECFSZDECFSZ f,df,d
RRFRRF f,df,d
RLFRLF f,df,d
SWAPFSWAPF f,df,d
INCFSZINCFSZ f,df,d

ByteByte--OrientedOriented
OperationsOperations
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PICmicro MCU指令集

字节操作

PICmicro MCU指令集

字节操作

MOVWF Move W to f
Syntax: MOVWF  f
Operands: 0 <= f <= 127
Operation: (W) -> (f)
Status: None
Encoding: 00 0000 1fff ffff
Words: 1
Cycles: 1

MOVWFMOVWF Move W to fMove W to f
Syntax:Syntax: MOVWF  fMOVWF  f
Operands:Operands: 0 <= f <= 1270 <= f <= 127
Operation:Operation: (W) (W) --> (f)> (f)
Status:Status: NoneNone
Encoding:Encoding: 00 0000 100 0000 1ffffff ffffffff
Words:Words: 11
Cycles:Cycles: 11

� 例:
MOVWF FSR

执行前

FSR = 0xFF
W = 0x4F

执行后

FSR = 0x4F
W = 0x4F

�� 例例::
MOVWFMOVWF FSRFSR

执行前执行前

FSRFSR = 0xFF= 0xFF
WW = 0x4F= 0x4F

执行后执行后

FSRFSR = 0x4F= 0x4F
WW = 0x4F= 0x4F
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PICmicro MCU指令集

字节操作

PICmicro MCU指令集

字节操作

CLRW Clear W
Syntax: CLRW
Operands: None
Operation: 00h -> (W)

1 -> Z
Status: Z
Encoding: 00 0001 0000 0000
Words: 1
Cycles: 1

CLRWCLRW Clear WClear W
Syntax:Syntax: CLRWCLRW
Operands:Operands: NoneNone
Operation:Operation: 00h 00h --> (W)> (W)

1 1 --> Z> Z
Status:Status: ZZ
Encoding:Encoding: 00 0001 0000 00 0001 0000 00000000
Words:Words: 11
Cycles:Cycles: 11

� 例:
CLRW

执行前

W = 0x4F

执行后

W = 0x00
Z = 1

�� 例例::
CLRWCLRW

执行前执行前

WW = 0x4F= 0x4F

执行后执行后

WW = 0x00= 0x00
ZZ = 1= 1
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PICmicro MCU指令集

字节操作

PICmicro MCU指令集

字节操作

CLRF Clear f
Syntax: CLRF  f
Operands: 0 <= f <= 127
Operation: 00h -> (f)

1 -> Z
Status: Z
Encoding: 00 0001 1fff ffff
Words: 1
Cycles: 1

CLRFCLRF Clear fClear f
Syntax:Syntax: CLRF  fCLRF  f
Operands:Operands: 0 <= f <= 1270 <= f <= 127
Operation:Operation: 00h 00h --> (f)> (f)

1 1 --> Z> Z
Status:Status: ZZ
Encoding:Encoding: 00 0001 100 0001 1ffffff ffffffff
Words:Words: 11
Cycles:Cycles: 11

� 例:
CLRF   FSR

执行前

FSR = 0x4F

执行后

FSR = 0x00
Z = 1

�� 例例::
CLRF   FSRCLRF   FSR

执行前执行前

FSRFSR = 0x4F= 0x4F

执行后执行后

FSRFSR = 0x00= 0x00
ZZ = 1= 1
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PICmicro MCU指令集

字节操作

PICmicro MCU指令集

字节操作

SUBWF Subtract W from f
Syntax: SUBWF  f,d
Operands: 0 <= f <= 127

d = {0,1}
Operation: (f) - (W) -> dest
Status: C,DC,Z
Encoding: 00 0010 dfff ffff
Words: 1
Cycles: 1

SUBWFSUBWF Subtract W from fSubtract W from f
Syntax:Syntax: SUBWF  SUBWF  f,df,d
Operands:Operands: 0 <= f <= 1270 <= f <= 127

d = {0,1}d = {0,1}
Operation:Operation: (f) (f) -- (W) (W) --> > destdest
Status:Status: C,DC,ZC,DC,Z
Encoding:Encoding: 00 0010 00 0010 ddffffff ffffffff
Words:Words: 11
Cycles:Cycles: 11

� 例:
SUBWF   FSR,W

执行前

FSR = 0x03
W = 0x02
C = ?
Z = ?
执行后

FSR = 0x03
W = 0x01
C = 1
Z = 0

�� 例例::
SUBWF   FSR,WSUBWF   FSR,W

执行前执行前

FSRFSR = 0x03= 0x03
WW = 0x02= 0x02
CC = ?= ?
ZZ = ?= ?
执行后执行后

FSRFSR = 0x03= 0x03
WW = 0x01= 0x01
CC = 1= 1
ZZ = 0= 0
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PICmicro MCU指令集

字节操作

PICmicro MCU指令集

字节操作

DECF Decrement f
Syntax: DECF  f,d
Operands: 0 <= f <= 127

d = {0,1}
Operation: (f) - 1 -> dest
Status: Z
Encoding: 00 0011 dfff ffff
Words: 1
Cycles: 1

DECFDECF Decrement fDecrement f
Syntax:Syntax: DECF  DECF  f,df,d
Operands:Operands: 0 <= f <= 1270 <= f <= 127

d = {0,1}d = {0,1}
Operation:Operation: (f) (f) -- 1 1 --> > destdest
Status:Status: ZZ
Encoding:Encoding: 00 0011 00 0011 ddffffff ffffffff
Words:Words: 11
Cycles:Cycles: 11

� 例:
DECF   FSR,F

执行前
FSR = 0x01
Z = 0

执行后
FSR = 0x00
Z = 1

�� 例例::
DECF   FSR,FDECF   FSR,F

执行前执行前

FSRFSR = 0x01= 0x01
ZZ = 0= 0

执行后执行后

FSRFSR = 0x00= 0x00
ZZ = 1= 1



© Microchip Technology Incorporated. All Rights Reserved.         701 PIC           701 PIC           PIC® MCU - Introduction to Programming          43

PICmicro MCU指令集

字节操作

PICmicro MCU指令集

字节操作

MOVF Move f
Syntax: MOVF  f,d
Operands: 0 <= f <= 127

d = {0,1}
Operation: (f) -> dest
Status: Z
Encoding: 00 1000 dfff ffff
Words: 1
Cycles: 1

MOVFMOVF Move fMove f
Syntax:Syntax: MOVF  MOVF  f,df,d
Operands:Operands: 0 <= f <= 1270 <= f <= 127

d = {0,1}d = {0,1}
Operation:Operation: (f) (f) --> > destdest
Status:Status: ZZ
Encoding:Encoding: 00 1000 00 1000 ddffffff ffffffff
Words:Words: 11
Cycles:Cycles: 11

� 例:
MOVF  FSR,F

执行前
FSR = 0x00
Z = 0

执行后
FSR = 0x00
Z = 1

�� 例例::
MOVF  FSR,FMOVF  FSR,F

执行前执行前

FSRFSR = 0x00= 0x00
ZZ = 0= 0

执行后执行后

FSRFSR = 0x00= 0x00
ZZ = 1= 1
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PICmicro MCU指令集

字节操作

PICmicro MCU指令集

字节操作

DECFSZ Dec. f, Skip if 0
Syntax: DECFSZ  f,d
Operands: 0 <= f <= 127

d = {0,1}
Operation: (f) - 1 -> dest

skip if result = 0
Status: None
Encoding: 00 1011 dfff ffff
Words: 1
Cycles: 1(2)

DECFSZDECFSZ Dec. f, Skip if 0Dec. f, Skip if 0
Syntax:Syntax: DECFSZ  DECFSZ  f,df,d
Operands:Operands: 0 <= f <= 1270 <= f <= 127

d = {0,1}d = {0,1}
Operation:Operation: (f) (f) -- 1 1 --> > destdest

skip if result = 0skip if result = 0
Status:Status: NoneNone
Encoding:Encoding: 00 1011 00 1011 ddffffff ffffffff
Words:Words: 11
Cycles:Cycles: 1(2)1(2)

例:
Loop DECFSZ  CNT,F

GOTO Loop
Continue

执行前

PC = address Loop
执行后

CNT = CNT - 1
if CNT = 0,
PC = address Continue
else CNT != 0,
PC = address Loop+1

例例::
LoopLoop DECFSZ  CNT,FDECFSZ  CNT,F

GOTOGOTO LoopLoop
ContinueContinue

执行前执行前

PC = address PC = address LoopLoop
执行后执行后

CNTCNT = = CNTCNT -- 11
if CNT = 0,if CNT = 0,
PC = address PC = address ContinueContinue
else CNT != 0,else CNT != 0,
PC = address PC = address LoopLoop+1+1
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PICmicro MCU指令集

字节操作

PICmicro MCU指令集

字节操作

RRF Rotate Right f -> C
Syntax: RRF  f,d
Operands: 0 <= f <= 127

d = {0,1}
Operation:

Status: C
Encoding: 00 1100 dfff ffff
Words: 1
Cycles: 1

RRFRRF Rotate Right f Rotate Right f --> C> C
Syntax:Syntax: RRF  RRF  f,df,d
Operands:Operands: 0 <= f <= 1270 <= f <= 127

d = {0,1}d = {0,1}
Operation:Operation:

Status:Status: CC
Encoding:Encoding: 00 1100 00 1100 ddffffff ffffffff
Words:Words: 11
Cycles:Cycles: 11

例:
RRF CNT,W

执行前

CNT = 1110 0110
C = 0

执行后

CNT = 1110 0110
W = 0111 0011
C = 0

例例::
RRFRRF CNT,WCNT,W

执行前执行前

CNTCNT = 1110 0110= 1110 0110
CC = 0= 0

执行后执行后

CNTCNT = 1110 0110= 1110 0110
WW = 0111 0011= 0111 0011
CC = 0= 0

CC Register fRegister f
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PICmicro MCU指令集PICmicro MCU指令集

1414位内核之位操作指令构成位内核之位操作指令构成

OP CODEOP CODE bb ff ff ff ff ff ff ff

b = 3b = 3--Bit AddressBit Address
(Bit Number)(Bit Number)

f = 7f = 7--bit Register Addressbit Register Address

bb bb

Example:Example:

BTFSCBTFSC STATUS, CSTATUS, C
BTFSCBTFSC f, bf, b

BCFBCF f,bf,b
BSFBSF f,bf,b
BTFSCBTFSC f,bf,b
BTFSSBTFSS f,bf,b

位操作
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PICmicro MCU指令集

位操作

PICmicro MCU指令集

位操作

BCF Bit Clear f
Syntax: BCF  f,b
Operands: 0 <= f <= 127

0 <= b <= 7
Operation: 0 -> (f<b>)
Status: None
Encoding: 01 00bb bfff ffff
Words: 1
Cycles: 1

BCFBCF Bit Clear fBit Clear f
Syntax:Syntax: BCF  BCF  f,bf,b
Operands:Operands: 0 <= f <= 1270 <= f <= 127

0 <= b <= 70 <= b <= 7
Operation:Operation: 0 0 --> (f<b>)> (f<b>)
Status:Status: NoneNone
Encoding:Encoding: 01 0001 00bbbb bbffffff ffffffff
Words:Words: 11
Cycles:Cycles: 11

� 例:
BCF  FSR,4

执行前
FSR = 0011 0000

执行后
FSR = 0010 0000

�� 例例::
BCF  FSR,4BCF  FSR,4

执行前执行前

FSRFSR = 0011 0000= 0011 0000

执行后执行后

FSRFSR = 0010 0000= 0010 0000
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PICmicro MCU指令集

位操作

PICmicro MCU指令集

位操作

BTFSS Bit Test f, Skip if 1
Syntax: BTFSS  f,b
Operands: 0 <= f <= 127

0 <= b <= 7
Operation: skip if (f<b>) = 1
Status: None
Encoding: 01 11bb bfff ffff
Words: 1
Cycles: 1(2)

BTFSSBTFSS Bit Test f, Skip if 1Bit Test f, Skip if 1
Syntax:Syntax: BTFSS  BTFSS  f,bf,b
Operands:Operands: 0 <= f <= 1270 <= f <= 127

0 <= b <= 70 <= b <= 7
Operation:Operation: skip if (f<b>) = 1skip if (f<b>) = 1
Status:Status: NoneNone
Encoding:Encoding: 01 1101 11bbbb bbffffff ffffffff
Words:Words: 11
Cycles:Cycles: 1(2)1(2)

例:
Here BTFSS    CNT,2
False GOTO Elsewhere
True

执行前

PC = address Here

执行后

if CNT<2> = 1,
PC = address True
if CNT<2> = 0,
PC = address False

例例::
HereHere BTFSS    CNT,2BTFSS    CNT,2
FalseFalse GOTOGOTO ElsewhereElsewhere
TrueTrue

执行前执行前

PC = address PC = address HereHere

执行后执行后

if CNT<2> = 1,if CNT<2> = 1,
PC = address PC = address TrueTrue
if CNT<2> = 0,if CNT<2> = 0,
PC = address PC = address FalseFalse
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PICmicro MCU指令集

立即数操作

PICmicro MCU指令集

立即数操作

kk

1414位内核之立即数操作指令构成位内核之立即数操作指令构成

OP CODEOP CODE kk kk kk kk kk kk kk

k = 8k = 8--bit Immediate Valuebit Immediate Value

例例::

MOVLWMOVLW 0x2F0x2F
MOVLWMOVLW kk

MOVLWMOVLW kk
IORLWIORLW kk
ADDLWADDLW kk
SUBLWSUBLW kk
ANDLWANDLW kk
XORLWXORLW kk

立即数操作立即数操作
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PICmicro MCU指令集

立即数操作

PICmicro MCU指令集

立即数操作

MOVLW 立即数送给 W
Syntax: MOVLW  k
Operands: 0 <= k <= 255
Operation: k -> (W) 
Status: None
Encoding: 11 0000 kkkk kkkk
Words: 1
Cycles: 1

MOVLWMOVLW 立即数送给立即数送给 WW
Syntax:Syntax: MOVLW  kMOVLW  k
Operands:Operands: 0 <= k <= 2550 <= k <= 255
Operation:Operation: k k --> (W) > (W) 
Status:Status: NoneNone
Encoding:Encoding: 11 0000 11 0000 kkkkkkkk kkkkkkkk
Words:Words: 11
Cycles:Cycles: 11

� 例:
MOVLW  0x5A

执行后
W = 0x5A

�� 例例::
MOVLW  0x5AMOVLW  0x5A

执行后执行后

WW = 0x5A= 0x5A
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PICmicro MCU指令集

立即数操作

PICmicro MCU指令集

立即数操作

ADDLW   W与立即数相加
Syntax: ADDLW  k

Operands: 0 <= k <= 255
Operation: (W) + k -> (W)
Status: C,DC,Z
Encoding: 11 1110 kkkk

kkkk
Words: 1
Cycles: 1

ADDLW   WADDLW   W与立即数相加与立即数相加
Syntax:Syntax: ADDLW  kADDLW  k

Operands:Operands: 0 <= k <= 2550 <= k <= 255
Operation:Operation: (W) + k (W) + k --> (W)> (W)
Status:Status: C,DC,ZC,DC,Z
Encoding:Encoding: 11 1110 11 1110 kkkkkkkk

kkkkkkkk
Words:Words: 11
Cycles:Cycles: 11

� 例:
ADDLW  0x15

执行前

W = 0x10

执行后
W = 0x25

�� 例例::
ADDLW  0x15ADDLW  0x15

执行前执行前

WW = 0x10= 0x10

执行后执行后

WW = 0x25= 0x25
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PICmicro MCU指令集

立即数操作

PICmicro MCU指令集

立即数操作

ANDLW W 与立即数相与

Syntax: ANDLW  k
Operands: 0 <= k <= 255
Operation: (W) AND k -> (W)
Status: Z
Encoding: 11 1001 kkkk kkkk
Words: 1
Cycles: 1

ANDLWANDLW W W 与立即数相与与立即数相与

Syntax:Syntax: ANDLW  kANDLW  k
Operands:Operands: 0 <= k <= 2550 <= k <= 255
Operation:Operation: (W) AND k (W) AND k --> (W)> (W)
Status:Status: ZZ
Encoding:Encoding: 11 1001 11 1001 kkkkkkkk kkkkkkkk
Words:Words: 11
Cycles:Cycles: 11

� 例:
ANDLW  0x5F

执行前

W = 0xA3

执行后
W = 0x03

�� 例例::
ANDLW  0x5FANDLW  0x5F

执行前执行前

WW = 0xA3= 0xA3

执行后执行后

WW = 0x03= 0x03
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PICmicro MCU指令集

控制类操作

PICmicro MCU指令集

控制类操作

kk

1414位内核之位内核之RETLWRETLW指令构成指令构成

OP CODEOP CODE kk kk kk kk kk kk kk

k = 8k = 8--bit Immediate Valuebit Immediate Value

SLEEPSLEEP --
CLRWDTCLRWDT --
RETLWRETLW kk
RETFIERETFIE --
RETURNRETURN --
CALLCALL kk
GOTOGOTO kk

控制类操作

1414位内核之位内核之CALL /GOTOCALL /GOTO指令构成指令构成

OP CODEOP CODE

k = 11k = 11--bit Immediate Valuebit Immediate Value

kk kk kk kk kk kk kk kk kk kk kk
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PICmicro MCU指令集

控制类操作

PICmicro MCU指令集

控制类操作

SLEEP 进入 SLEEP 
Syntax: SLEEP
Operands: None
Operation: 00h -> WDT

1 -> TO
0 -> PD

Status: TO, PD
Encoding: 00 0000 0110 0011
Words: 1
Cycles: 1

SLEEPSLEEP 进入进入 SLEEP SLEEP 
Syntax:Syntax: SLEEPSLEEP
Operands:Operands: NoneNone
Operation:Operation: 00h 00h --> WDT> WDT

1 1 --> TO> TO
0 0 --> PD> PD

Status:Status: TO, PDTO, PD
Encoding:Encoding: 00 0000 0110 001100 0000 0110 0011
Words:Words: 11
Cycles:Cycles: 11

� 例:
SLEEP

�� 例例::
SLEEPSLEEP
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CLRWDT 清 Watchdog
Syntax: CLRWDT
Operands: None
Operation: 00h -> WDT

0 -> WDT prescaler
1 -> TO
1 -> PD

Status: TO, PD
Encoding: 00 0000 0110 0100
Words: 1
Cycles: 1

CLRWDTCLRWDT 清清 WatchdogWatchdog
Syntax:Syntax: CLRWDTCLRWDT
Operands:Operands: NoneNone
Operation:Operation: 00h 00h --> WDT> WDT

0 0 --> WDT > WDT prescalerprescaler
1 1 --> TO> TO
1 1 --> PD> PD

Status:Status: TO, PDTO, PD
Encoding:Encoding: 00 0000 0110 010000 0000 0110 0100
Words:Words: 11
Cycles:Cycles: 11

PICmicro指令集

控制类操作

PICmicro指令集

控制类操作

� 例:
CLRWDT

�� 例例::
CLRWDTCLRWDT
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PICmicro MCU指令集

控制类操作

PICmicro MCU指令集

控制类操作

RETLW 返回

Syntax: RETLW  k
Operands: 0 <= k <= 255
Operation: k -> (W)

TOS -> PC 
Status: None
Encoding: 11 0100 kkkk kkkk
Words: 1
Cycles: 2

RETLWRETLW 返回返回

Syntax:Syntax: RETLW  kRETLW  k
Operands:Operands: 0 <= k <= 2550 <= k <= 255
Operation:Operation: k k --> (W)> (W)

TOS TOS --> PC > PC 
Status:Status: NoneNone
Encoding:Encoding: 11 0100 11 0100 kkkkkkkk kkkkkkkk
Words:Words: 11
Cycles:Cycles: 22

� 例:
RETLW  0x5A

执行后
W = 0x5A

�� 例例::
RETLW  0x5ARETLW  0x5A

执行后执行后

WW = 0x5A= 0x5A
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PICmicro MCU指令集

控制类操作

PICmicro MCU指令集

控制类操作

RETFIE 中断返回

Syntax: RETFIE
Operands: None
Operation: TOS -> PC

1 -> GIE 
Status: None
Encoding: 00 0000 0000 1001
Words: 1
Cycles: 2

RETFIERETFIE 中断返回中断返回

Syntax:Syntax: RETFIERETFIE
Operands:Operands: NoneNone
Operation:Operation: TOS TOS --> PC> PC

1 1 --> GIE > GIE 
Status:Status: NoneNone
Encoding:Encoding: 00 0000 00 0000 00000000 10011001
Words:Words: 11
Cycles:Cycles: 22

� 例:
RETFIE

�� 例例::
RETFIERETFIE
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PICmicro MCU指令集

控制类操作

PICmicro MCU指令集

控制类操作

CALL 调用子程序

Syntax: CALL k
Operands: 0 <= f <= 2047
Operation: (PC) + 1 -> TOS

k -> PC<10:0>
PCLATH<4:3 ->

PC<12:11>
Status: None
Encoding: 10 0kkk kkkk kkkk
Words: 1
Cycles: 2

CALLCALL 调用子程序调用子程序

Syntax:Syntax: CALL kCALL k
Operands:Operands: 0 <= f <= 20470 <= f <= 2047
Operation:Operation: (PC) + 1 (PC) + 1 --> TOS> TOS

k k --> PC<10:0>> PC<10:0>
PCLATH<4:3 PCLATH<4:3 -->>

PC<12:11>PC<12:11>
Status:Status: NoneNone
Encoding:Encoding: 10 010 0kkkkkk kkkkkkkk kkkkkkkk
Words:Words: 11
Cycles:Cycles: 22

例:
Here CALL There

执行前
PC = address Here

执行后
PC = address There
TOS = address Here+1

例例::
HereHere CALLCALL ThereThere

执行前执行前

PC = address PC = address HereHere

执行后执行后

PC = address PC = address ThereThere
TOS = address TOS = address Here+1Here+1
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PICmicro MCU指令集

控制类操作

PICmicro MCU指令集

控制类操作

GOTO 无条件转移

Syntax: GOTO k
Operands: 0 <= f <= 2047
Operation: k -> PC<10:0>

PCLATH<4:3> ->
PC<12:11>

Status: None
Encoding: 10 1kkk kkkk kkkk
Words: 1
Cycles: 2

GOTOGOTO 无条件转移无条件转移

Syntax:Syntax: GOTO kGOTO k
Operands:Operands: 0 <= f <= 20470 <= f <= 2047
Operation:Operation: k k --> PC<10:0>> PC<10:0>

PCLATH<4:3> PCLATH<4:3> -->>
PC<12:11>PC<12:11>

Status:Status: NoneNone
Encoding:Encoding: 10 110 1kkkkkk kkkkkkkk kkkkkkkk
Words:Words: 11
Cycles:Cycles: 22

例:
GOTO There

执行后
PC = address There

例例::
GOTOGOTO ThereThere

执行后执行后

PC = address PC = address ThereThere
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使用 MPLAB® 集成开发环境 (IDE)     
MPASM™ 编译器

使用使用 MPLABMPLAB®® 集成开发环境集成开发环境 ((IDE)     IDE)     
MPASMMPASM™™ 编译器编译器
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汇编 指令汇编汇编 指令指令

� #INCLUDE
� 语法:  #include “文件名.*” 或<文件名.*> 或无括号 或 引号:
� 示例:   #INCLUDE p12f675.inc

�� ##INCLUDEINCLUDE
�� 语法语法:  #:  #include include ““文件名文件名.*.*”” 或或<<文件名文件名.*> .*> 或无括号或无括号 或或 引号引号::
�� 示例示例:   :   ##INCLUDE INCLUDE p12f675.incp12f675.inc
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汇编 指令汇编汇编 指令指令

� #DEFINE
� 用于定义变量和分配初始值

� 用户友好的名字被分配给常数,寄存器 ,管脚名等.
� 使程序易读

� 例:   #DEFINE MYCONSTANT H’5A’

� _ _CONFIG
� 设置配置位

� 见 Lab 2

�� ##DEFINEDEFINE
�� 用于定义变量和分配初始值用于定义变量和分配初始值

�� 用户友好的名字被分配给常数用户友好的名字被分配给常数,,寄存器寄存器 ,,管脚名等管脚名等..
�� 使程序易读使程序易读

�� 例例:   :   ##DEFINE DEFINE MYCONSTANTMYCONSTANT HH’’5A5A’’

�� _ _CONFIG_ _CONFIG
�� 设置配置位设置配置位

�� 见见 Lab 2Lab 2
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汇编 指令汇编汇编 指令指令

� ORG
� 语法: ORG   <address>
� 例: ORG 0x0000
� 描述:  定义起始地址(0x0000).

�� ORGORG
�� 语法语法: : ORG   <address>ORG   <address>
�� 例例: : ORGORG 0x00000x0000
�� 描述描述:  :  定义起始地址定义起始地址(0x0000).(0x0000).
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汇编指令汇编指令汇编指令

� EQU
� 语法: <label> equ <expr>
� 例: Seconds EQU 0x24
� 描述: 定义常数或变量的替换名.  

� …可用做常数

� movlw SECONDS ; put 24 (hex) into W

� ... 或当作寄存器地址

� movwf SECONDS ; put value in W into                          
; RAM location 24 (hex).

�� EQUEQU
�� 语法语法: <: <label> label> equequ <<exprexpr>>
�� 例例: : Seconds Seconds EQU EQU 0x240x24
�� 描述描述: : 定义常数或变量的替换名定义常数或变量的替换名.  .  

�� ……可用做常数可用做常数

�� movlwmovlw SECONDSSECONDS ; put 24 (hex) into W; put 24 (hex) into W

�� ... ... 或当作寄存器地址或当作寄存器地址

�� movwfmovwf SECONDSSECONDS ; put value in W into                          ; put value in W into                           
; RAM location 24 (hex).; RAM location 24 (hex).
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汇编指令汇编指令汇编指令

� BANKSEL
� 语法: BANKSEL [<variable>]
� 例: 

BANKSEL   TRISA    
movwf TRISA

� 设置相关的 bank 位

�� BANKSELBANKSEL
�� 语法语法: : BANKSEL [<variable>]BANKSEL [<variable>]
�� 例例: : 

BANKSEL   BANKSEL   TRISA    TRISA    
movwfmovwf TRISATRISA

�� 设置相关的设置相关的 bank bank 位位



© Microchip Technology Incorporated. All Rights Reserved.         701 PIC           701 PIC           PIC® MCU - Introduction to Programming          66

汇编指令汇编指令汇编指令

� END
� 语法:  END
� 例: 表示原代码结束.

� 你必须在想结束汇编的地方有一条 END语
句.

�� ENDEND
�� 语法语法:  :  ENDEND
�� 例例: : 表示原代码结束表示原代码结束..

�� 你必须在想结束汇编的地方有一条你必须在想结束汇编的地方有一条 ENDEND语语
句句..
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休息休息休息
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Lab 1

在MPLAB 7.x中创建一个项目

Lab 1Lab 1

在在MPLAB 7.xMPLAB 7.x中创建一个项目中创建一个项目
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Lab 1
MPLAB® 7.xx 布局

Lab 1Lab 1
MPLABMPLAB®® 7.xx 7.xx 布局布局

状态栏

图标栏

Workspace
项目窗口

输出窗口

Buttons are added to the 
Toolbar as features are enabled
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创建项目创建项目创建项目

� Lab 1 目标

� 使用Project Wizard
� 编写简单的MPASM代码

� 编译代码

� 介绍 输出窗口 和Program Memory 窗口

� 选择Build选项

�� Lab 1 Lab 1 目标目标

�� 使用使用Project WizardProject Wizard
�� 编写简单的编写简单的MPASMMPASM代码代码

�� 编译代码编译代码

�� 介绍介绍 输出窗口输出窗口 和和Program Memory Program Memory 窗口窗口

�� 选择选择BuildBuild选项选项
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创建项目创建项目创建项目

� Project -> Project Wizard...
� 打开 Project Wizard ,创建一

个项目

�� Project Project --> Project Wizard...> Project Wizard...
�� 打开打开 Project Wizard ,Project Wizard ,创建一创建一

个项目个项目
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Lab 1
从任一项目开始

Lab 1Lab 1
从任一项目开始从任一项目开始

� 按照下列步骤创建
项目:

� 点击“Next” 继续.

� 选择MCU型号

� 使用最新的
MPLAB IDE 版本

�� 按照下列步骤创建按照下列步骤创建
项目项目::

�� 点击点击““NextNext”” 继续继续..

�� 选择选择MCUMCU型号型号

�� 使用最新的使用最新的
MPLAB IDE MPLAB IDE 版本版本
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Lab 1
从任一项目开始

Lab 1Lab 1
从任一项目开始从任一项目开始

� 选择语言工具:
� MPASM 汇编器 免

费,本课将使用 .

� 显示安装后子目录, 
你也可以更改 .

� 当然你可以点出
“Help” 或 “Show 
all”查看所有的语言
工具.

�� 选择语言工具选择语言工具::
�� MPASM MPASM 汇编器汇编器 免免

费费,,本课将使用本课将使用 ..

�� 显示安装后子目录显示安装后子目录, , 
你也可以更改你也可以更改 ..

�� 当然你可以点出当然你可以点出
““HelpHelp”” 或或 ““Show Show 
allall””查看所有的语言查看所有的语言
工具工具..
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Lab 1
从任一项目开始

Lab 1Lab 1
从任一项目开始从任一项目开始

� 选择路径:
� 键入项目名字.

� 键入项目路径.

� 注意路径尽可能
短.

�� 选择路径选择路径::
�� 键入项目名字键入项目名字..

�� 键入项目路径键入项目路径..

�� 注意路径尽可能注意路径尽可能
短短..
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Lab 1
从任一项目开始

Lab 1Lab 1
从任一项目开始从任一项目开始

� 增加文件

� 增加文件到项目
中.

�� 增加文件增加文件

�� 增加文件到项目增加文件到项目
中中..
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Lab 1
从任一项目开始

Lab 1Lab 1
从任一项目开始从任一项目开始

� 完成

� 创建的项目的小
结被显示, 点击
“finish” 完成 .

� 记住, Project 
Wizard 新版本将
会增加一些新的
功能.

�� 完成完成

�� 创建的项目的小创建的项目的小
结被显示结被显示, , 点击点击
““finishfinish”” 完成完成 ..

�� 记住记住, , Project Project 
Wizard Wizard 新版本将新版本将
会增加一些新的会增加一些新的
功能功能..
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Lab 1
从任一项目开始

Lab 1Lab 1
从任一项目开始从任一项目开始

� (*.mcp)和 (*.mcw)文件
名将被显示 .

� 在窗口你可以添加任何
类型相关的文件到项目
中

�� (*.(*.mcpmcp))和和 (*.(*.mcwmcw))文件文件
名将被显示名将被显示 ..

�� 在窗口你可以添加任何在窗口你可以添加任何
类型相关的文件到项目类型相关的文件到项目
中中
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Lab 1
从任一项目开始

Lab 1Lab 1
从任一项目开始从任一项目开始

� 选择File > New创建新
文件

� 键入右图所示的代码. 

� “*” 表示文件已被改变.

� 键入的代码执行nop’s
功能.

�� 选择选择File > NewFile > New创建新创建新
文件文件

�� 键入右图所示的代码键入右图所示的代码. . 

�� ““**”” 表示文件已被改变表示文件已被改变..

�� 键入的代码执行键入的代码执行nopnop’’ss
功能功能..
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Lab 1
从任一项目开始

Lab 1Lab 1
从任一项目开始从任一项目开始

� 选择File > Save As保
存文件..

� 保存 例子文件 为
Lab1.asm.

�� 选择选择File > Save AsFile > Save As保保
存文件存文件....

�� 保存保存 例子文件例子文件 为为
Lab1.asm.Lab1.asm.
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Lab 1
从任一项目开始

Lab 1Lab 1
从任一项目开始从任一项目开始

� 在source code栏增加文件

� 鼠标右击 “Source Files”
选择 “Add Files”.

� 增加 Lab1.asm文件.

�� 在在source codesource code栏增加文件栏增加文件

�� 鼠标右击鼠标右击 ““Source FilesSource Files””
选择选择 ““Add FilesAdd Files””..

�� 增加增加 Lab1.asmLab1.asm文件文件..
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Lab 1
从任一项目开始

Lab 1Lab 1
从任一项目开始从任一项目开始

� 文件现在增加在Project
中

� 注意“*” 表示文件已被
改变未保存. 

�� 文件现在增加在文件现在增加在ProjectProject
中中

�� 注意注意““**”” 表示文件已被表示文件已被
改变未保存改变未保存. . 
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Lab 1Lab 1Lab 1

� 选择File > Save Workspace保
存项目

�� 选择选择File > Save WorkspaceFile > Save Workspace保保
存项目存项目



© Microchip Technology Incorporated. All Rights Reserved.         701 PIC           701 PIC           PIC® MCU - Introduction to Programming          83

编译代码编译代码编译代码

� 选择Project -> Build All编译
项目

� “Build All” 表示 每一个文件
被改变,因此重新编译所有项
目

�� 选择选择Project Project --> Build All> Build All编译编译
项目项目

�� ““Build AllBuild All”” 表示表示 每一个文件每一个文件
被改变被改变,,因此重新编译所有项因此重新编译所有项
目目
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Lab 1
从任一项目开始

Lab 1Lab 1
从任一项目开始从任一项目开始

� 输出窗口 显示 build的过程.�� 输出窗口输出窗口 显示显示 buildbuild的过程的过程..
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Lab 1
从任一项目开始

Lab 1Lab 1
从任一项目开始从任一项目开始

� 选择View > Program Memory可以查看程序区�� 选择选择View > Program MemoryView > Program Memory可以查看程序区可以查看程序区

Your Code

Unprogrammed locations (3FFF)
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MPLAB® IDE 
设置信息

MPLABMPLAB®® IDE IDE 
设置信息设置信息

� Workspace:    
� 包含下列信息:

� MCU型号

� 调试工具或编程器

� 打开的窗口

� IDE configuration 的设置值

� Project:    
� 包含所有的源文件

�� Workspace:    Workspace:    
�� 包含下列信息包含下列信息::

�� MCUMCU型号型号

�� 调试工具或编程器调试工具或编程器

�� 打开的窗口打开的窗口

�� IDE configuration IDE configuration 的设置值的设置值

�� Project:    Project:    
�� 包含所有的源文件包含所有的源文件
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MPLAB® IDE 窗口MPLABMPLAB®® IDE IDE 窗口窗口

� 新的工作界面有下列窗口
� Project - 工程项目

� Output - 输出信息

� Disassembly - 反汇编

� Watch - 变量观察

� Hardware Stack - 硬件堆栈信息

� Program memory - 程序空间内容

� File Registers - 寄存器内容

� EEPROM data - EEPROM数据内容

� Special Function Registers - 特殊功能寄存器

�� 新的工作界面有下列窗口新的工作界面有下列窗口
�� ProjectProject -- 工程项目工程项目

�� OutputOutput -- 输出信息输出信息

�� DisassemblyDisassembly -- 反汇编反汇编

�� WatchWatch -- 变量观察变量观察

�� Hardware StackHardware Stack -- 硬件堆栈信息硬件堆栈信息

�� Program memoryProgram memory -- 程序空间内容程序空间内容

�� File RegistersFile Registers -- 寄存器内容寄存器内容

�� EEPROM dataEEPROM data -- EEPROMEEPROM数据内容数据内容

�� Special Function RegistersSpecial Function Registers -- 特殊功能寄存器特殊功能寄存器

Note: There are often more windows, but they will depend on the device used and debugger/programmer tool.Note:Note: There are often more windows, but they will depend on the devicThere are often more windows, but they will depend on the device used and debugger/programmer tool.e used and debugger/programmer tool.
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Lab 1
设置 Build 选项

Lab 1Lab 1
设置设置 Build Build 选项选项

� 在Project Window右击项目
文件 ( 也可以选择“Project”
菜单)

� 选择“Build Options...”更改
设置

�� 在在Project WindowProject Window右击项目右击项目
文件文件 (( 也可以选择也可以选择““ProjectProject””
菜单菜单))

�� 选择选择““Build Options...Build Options...””更改更改
设置设置



© Microchip Technology Incorporated. All Rights Reserved.         701 PIC           701 PIC           PIC® MCU - Introduction to Programming          89

Lab 1
设置 Build 选项

Lab 1Lab 1
设置设置 Build Build 选项选项

� The Build Options 窗
口有多个设置窗口

� 使用下拉菜单改变类
型

� 选择你需要的选项

� 通常采用缺省值

�� The The Build OptionsBuild Options 窗窗
口有多个设置窗口口有多个设置窗口

�� 使用下拉菜单改变类使用下拉菜单改变类
型型

�� 选择你需要的选项选择你需要的选项

�� 通常采用缺省值通常采用缺省值
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Lab 1 – 注意事项Lab 1 Lab 1 –– 注意事项注意事项

� 首先必须生成项目 或 文件

� .asm文件必须添加到项目

� 使用 Configuration 菜单选择型号

� 编译 项目生成 .hex 文件

�� 首先必须生成项目首先必须生成项目 或或 文件文件

�� ..asmasm文件必须添加到项目文件必须添加到项目

�� 使用使用 Configuration Configuration 菜单选择型号菜单选择型号

�� 编译编译 项目生成项目生成 ..hex hex 文件文件
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Lab 2
使用 MPLAB ICD 2

Lab 2Lab 2
使用使用 MPLAB ICD 2MPLAB ICD 2
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开始 Lab 2开始开始 Lab 2Lab 2

� Lab 2 目标

� 介绍 MPLAB ICD 2 和 PICDEM™ 2 Plus
� 验证逻辑跳转

� 编写代码测试按键输入

�� Lab 2 Lab 2 目标目标

�� 介绍介绍 MPLAB ICD 2 MPLAB ICD 2 和和 PICDEMPICDEM™™ 2 Plus2 Plus
�� 验证逻辑跳转验证逻辑跳转

�� 编写代码测试按键输入编写代码测试按键输入
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MPLAB ICD 2 套件(DV164006) MPLAB ICD 2 MPLAB ICD 2 套件套件((DV164006DV164006) ) 

� 套件包含:
� MPLAB ICD 2 
� 所有电缆包括USB电缆

� 电源

� CD-ROM
� 资料

� PICDEM 2 Plus 演示板及:
� 样品 (PIC18F452, PIC16F877)
� 功能! (LCD, 温度传感器, 等)

�� 套件包含套件包含::
�� MPLAB ICD 2 MPLAB ICD 2 
�� 所有电缆包括所有电缆包括USBUSB电缆电缆

�� 电源电源

�� CDCD--ROMROM
�� 资料资料

�� PICDEM 2 Plus PICDEM 2 Plus 演示板及演示板及::
�� 样品样品 ((PIC18F452, PIC16F877)PIC18F452, PIC16F877)
�� 功能功能! (! (LCD, LCD, 温度传感器温度传感器, , 等等))
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PICDEM 2 Plus 演示板PICDEM 2 Plus PICDEM 2 Plus 演示板演示板

� 可单独购买

� DV164006 ICD 2套件内含

� 与 ICD 2直接相连

� ICD 2供电或外接电源

� 可演示许多功能

�� 可单独购买可单独购买

�� DV164006DV164006 ICD 2ICD 2套件内含套件内含

�� 与与 ICD 2ICD 2直接相连直接相连

�� ICD 2ICD 2供电或外接电源供电或外接电源

�� 可演示许多功能可演示许多功能

� 注意订单时订购DV164006!
� DV164007 不包含 PICDEM 2 Plus 和 样品

� DV164005 仅包含ICD2,无 电缆, 电源,样品等.

�� 注意订单时订购注意订单时订购DV164006DV164006!!
�� DV164007 DV164007 不包含不包含 PICDEM 2 Plus PICDEM 2 Plus 和和 样品样品

�� DV164005 DV164005 仅包含仅包含ICD2,ICD2,无无 电缆电缆, , 电源电源,,样品等样品等..
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跳转跳转跳转

� 循环种类:
� 定时

� 嵌套

� 计数

� 延时

�� 循环种类循环种类::
�� 定时定时

�� 嵌套嵌套

�� 计数计数

�� 延时延时

� 指令:
� BTFSS Bit Test File Skip if Set
� BTFSC Bit Test File Skip if Clear
� DECFSZ DECrement File Skip when Zero
� INCFSZ INCrement File Skip when Zero

�� 指令指令::
�� BTFSSBTFSS BBit it TTest est FFile ile SSkip if kip if SSetet
�� BTFSCBTFSC BBit it TTest est FFile ile SSkip if kip if CClearlear
�� DECFSZDECFSZ DECDECrementrement FFile ile SSkip when kip when ZZeroero
�� INCFSZINCFSZ INCINCrementrement FFile ile SSkip when kip when ZZeroero
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Delay ; Delay code using decfsz instruction
decfsz MyVar,F ; Decrement MyVar, skip if 0
goto Delay ; since MyVar is not 0, go back
bsf PORTB, RB0 ; MyVar now 0, light LED and continue

DelayDelay ; Delay code using ; Delay code using decfszdecfsz instructioninstruction
decfszdecfsz MyVar,FMyVar,F ; Decrement ; Decrement MyVarMyVar, skip if 0, skip if 0
gotogoto DelayDelay ; since ; since MyVarMyVar is not 0, go backis not 0, go back
bsfbsf PORTB, RB0PORTB, RB0 ; ; MyVarMyVar now 0, light LED and continuenow 0, light LED and continue

跳转跳转跳转

� 指令

� BTFSS Bit Test File Skip if Set
� BTFSC Bit Test File Skip if Clear
� DECFSZ DECrement File Skip when Zero
� INCFSZ INCrement File Skip when Zero

�� 指令指令

�� BTFSSBTFSS Bit Test File Skip if SetBit Test File Skip if Set
�� BTFSCBTFSC Bit Test File Skip if ClearBit Test File Skip if Clear
�� DECFSZDECFSZ DECDECrementrement FFile ile SSkip when kip when ZZeroero
�� INCFSZINCFSZ INCrementINCrement File Skip when ZeroFile Skip when Zero

MyVar
22

decfszdecfsz MyVar,FMyVar,F
gotogoto DelayDelay
decfszdecfsz MyVar,FMyVar,F

1100

bsfbsf PORTB, RB0PORTB, RB0
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跳转指令跳转指令跳转指令

� Status Bits
� N Negative
� OV Overflow
� Z Zero
� DC Digit Carry
� C Carry

� Status Bits
� N Negative
� OV Overflow
� Z Zero
� DC Digit Carry
� C Carry

-- -- -- NN OVOV ZZ DCDC CC

STATUS

� 使用跳转指令测试任何一个位 :
� SFR
� 变量 (GPR)
� STATUS 寄存器

�� 使用使用跳转指令跳转指令测试任何一个位测试任何一个位 ::
�� SFRSFR
�� 变量变量 ((GPR)GPR)
�� STATUSSTATUS 寄存器寄存器
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Lab 2: 内容Lab 2: Lab 2: 内容内容

� 测试按键输入
� 读PORTx,y

� “x” 是口的名字(例PORTA )
� “y” 是第几位(0 到 7)

� 程序跳转
� 通过btfsc or btfss 跳转

� 指令跳过 或 或不跳过 下一条指令

� 根据跳转点亮 LED 

� 用MPLAB® SIM, MPLAB® ICD2 和 PICDEM™ 2 Plus验证

�� 测试按键输入测试按键输入
�� 读读PORTPORTxx,,yy

�� ““xx”” 是口的名字是口的名字((例例PORTA )PORTA )
�� ““yy”” 是第几位是第几位(0 (0 到到 7)7)

�� 程序跳转程序跳转
�� 通过通过btfscbtfsc or or btfssbtfss 跳转跳转

�� 指令跳过指令跳过 或或 或不跳过或不跳过 下一条指令下一条指令

�� 根据跳转点亮根据跳转点亮 LED LED 

�� 用用MPLABMPLAB®® SIM, MPLABSIM, MPLAB®® ICD2 ICD2 和和 PICDEMPICDEM™™ 2 Plus2 Plus验证验证
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LAB 2LAB 2LAB 2

� 测试按键输入�� 测试按键输入测试按键输入

#INCLUDE p16F877A.inc ; Include the standard definitions

clrf PORTB ; Initialize PORTB so that all LEDs are off by default
BANKSEL TRISB ; BANKSEL is used to get to bank with TRISB in it (bank 1)
clrf TRISB ; Clear TRISB to make all PORTB pins outputs
movlw B’00010000’ ; Make pin RA4 an input (rest of PORTA pins are outputs)
movwf TRISA ; This is redundant as TRISA bits are 1’s by default (inputs)

; (the rest of the pins are set low)

movlw H’07’ ; Writing 7 into ADCON1 causes all analog pins to allow
movwf ADCON1 ; digital input.  You must set ADCON1 when using pins with 

; A/D functions as they are analog mode by default.
; This code isn’t needed in this example - do you know why?

##INCLUDE p16F877A.incINCLUDE p16F877A.inc ; Include the standard definitions; Include the standard definitions

clrfclrf PORTBPORTB ; Initialize PORTB so that all ; Initialize PORTB so that all LEDsLEDs are off by defaultare off by default
BANKSELBANKSEL TRISBTRISB ; BANKSEL is used to get to bank with TRISB in it (bank 1); BANKSEL is used to get to bank with TRISB in it (bank 1)
clrfclrf TRISBTRISB ; Clear TRISB to make all PORTB pins outputs; Clear TRISB to make all PORTB pins outputs
movlwmovlw BB’’0001000000010000’’ ; Make pin RA4 an input (rest of PORTA pins are outputs); Make pin RA4 an input (rest of PORTA pins are outputs)
movwfmovwf TRISATRISA ; This is redundant as TRISA bits are 1; This is redundant as TRISA bits are 1’’s by default (inputs)s by default (inputs)

; (the rest of the pins are set low); (the rest of the pins are set low)

movlwmovlw HH’’0707’’ ; Writing 7 into ADCON1 causes all analog pins to allow; Writing 7 into ADCON1 causes all analog pins to allow
movwfmovwf ADCON1ADCON1 ; digital input.  You must set ADCON1 when using pins with ; digital input.  You must set ADCON1 when using pins with 

; A/D functions as they are analog mode by default.; A/D functions as they are analog mode by default.
; ; This code isnThis code isn’’t neededt needed in this example in this example -- do you know why?do you know why?
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LAB 2LAB 2LAB 2

BANKSEL PORTA ; BANKSEL is used to return to bank 0 (for PORTA, PORTB)
Loop btfss PORTA,4 ; Test RA4 on PORTA, skip if pin is high

goto On ; go to “On” code if button is pressed (pressed button is low)

Off movlw B’00000010’ ; “On” code is skipped so “Off” code runs - it writes a value to
movwf PORTB ; PORTB to turn on RB1 (high) and sets rest of PORTB low
goto Loop ; The test of the button happens again by branching to “Loop”

On movlw B’00001000’ ; “On” code writes a value to PORTB to turn on RB3 (high)
movwf PORTB ; and sets rest of PORTB low, including RB1.
goto Loop ; The test of the button happens again by branching to “Loop”

Here goto Here ; This code is not needed either.  Why?
END ; All programs must have an END directive

BANKSELBANKSEL PORTAPORTA ; BANKSEL is used to return to bank 0 (for PORTA, PORTB); BANKSEL is used to return to bank 0 (for PORTA, PORTB)
LoopLoop btfssbtfss PORTA,4PORTA,4 ; Test RA4 on PORTA, skip if pin is high; Test RA4 on PORTA, skip if pin is high

gotogoto OnOn ; go to ; go to ““OnOn”” code if button is pressed (pressed button is low)code if button is pressed (pressed button is low)

OffOff movlwmovlw BB’’0000001000000010’’ ; ; ““OnOn”” code is skipped so code is skipped so ““OffOff”” code runs code runs -- it writes a value toit writes a value to
movwfmovwf PORTBPORTB ; PORTB to turn on RB1 (high) and sets rest of PORTB low; PORTB to turn on RB1 (high) and sets rest of PORTB low
gotogoto LoopLoop ; The test of the button happens again by branching to ; The test of the button happens again by branching to ““LoopLoop””

OnOn movlwmovlw BB’’0000100000001000’’ ; ; ““OnOn”” code writes a value to PORTB to turn on RB3 (high)code writes a value to PORTB to turn on RB3 (high)
movwfmovwf PORTBPORTB ; and sets rest of PORTB low, including RB1.; and sets rest of PORTB low, including RB1.
gotogoto LoopLoop ; The test of the button happens again by branching to ; The test of the button happens again by branching to ““LoopLoop””

Here Here gotogoto HereHere ; ; This code is not neededThis code is not needed either.  Why?either.  Why?
ENDEND ; All programs must have an END directive; All programs must have an END directive
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� 打开 Lab2.asm
� 使用 File -> Open

� 创建项目

� 使用 Project Wizard 

�� 打开打开 Lab2.asmLab2.asm
�� 使用使用 File File --> Open> Open

�� 创建项目创建项目

�� 使用使用 Project Wizard Project Wizard 

Lab 2:
开始

Lab 2:Lab 2:
开始开始



© Microchip Technology Incorporated. All Rights Reserved.         701 PIC           701 PIC           PIC® MCU - Introduction to Programming          102

� ICD 2与计算机
相连, 目标板上
电,然后ICD 2 与
目标板相连

� 使能 MPLAB 
ICD 2 

�� ICD 2ICD 2与计算机与计算机
相连相连, , 目标板上目标板上
电电,,然后然后ICD 2 ICD 2 与与
目标板相连目标板相连

�� 使能使能 MPLAB MPLAB 
ICD 2 ICD 2 

Lab 2:
设置 MPLAB ICD 2

Lab 2:Lab 2:
设置设置 MPLAB ICD 2MPLAB ICD 2

USB
Connect to PC
USBUSB
Connect to PCConnect to PC

11

ICD 2ICD 2

Power SupplyPower Supply22

33
6 Pin “Phone” jack 
to PICDEM 2 Plus
6 6 Pin Pin ““PhonePhone”” jack jack 
to PICDEM 2 Plusto PICDEM 2 Plus

Connect
Power
ConnectConnect
PowerPower

PICDEM 2 PlusPICDEM 2 Plus



© Microchip Technology Incorporated. All Rights Reserved.         701 PIC           701 PIC           PIC® MCU - Introduction to Programming          103

Lab 2
用 MPLAB ICD 2调试

Lab 2Lab 2
用用 MPLAB ICD 2MPLAB ICD 2调试调试

� 使能ICD2, 编译代码.

� 你必须先编程器件

� 编程后, 可尝试全速运行,单步走. 

� 查看 watch 窗口.

�� 使能使能ICD2, ICD2, 编译代码编译代码..

�� 你必须先编程你必须先编程器件器件

�� 编程后编程后, , 可尝试全速运行可尝试全速运行,,单步走单步走. . 

�� 查看查看 watch watch 窗口窗口..
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Lab 2
使能 MPLAB ICD 2

Lab 2Lab 2
使能使能 MPLAB ICD 2MPLAB ICD 2

� 一旦使能, 许多选项将允
许.  

� 你可编程或调试

� 记住设置Configuration 
Bits!

�� 一旦使能一旦使能, , 许多选项将允许多选项将允
许许.  .  

�� 你可编程或调试你可编程或调试

�� 记住设置记住设置Configuration Configuration 
Bits!Bits!
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Lab 2
配置位

Lab 2Lab 2
配置位配置位

� PIC® MCU有 Configuration 
Bits

� Configuration bits 在编程或调
试时被设置.

� 打开Configure -> 
Configuration Bits, 先设置后编

程.

� Configuration Bits 
非常重要!

�� PICPIC®® MCUMCU有有 Configuration Configuration 
BitsBits

�� Configuration bits Configuration bits 在编程或调在编程或调
试时被设置试时被设置..

�� 打开打开Configure Configure --> > 
Configuration BitsConfiguration Bits, , 先设置后编先设置后编

程程..

�� Configuration Bits Configuration Bits 
非常重要非常重要!!
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用__CONFIG设置配置位用用____CONFIGCONFIG设置配置位设置配置位

� _ _CONFIG
� CONFIG字键入两个下划线

� 使用INCLUDE(*.inc) 
� 用来设置CONFIGURATION 寄存器

�� _ __ _CONFIGCONFIG
�� CONFIGCONFIG字键入两个下划线字键入两个下划线

�� 使用使用INCLUDE(*.inc) INCLUDE(*.inc) 
�� 用来设置用来设置CONFIGURATION CONFIGURATION 寄存器寄存器
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用__CONFIG设置配置位用用____CONFIGCONFIG设置配置位设置配置位

� 例:(PIC16F877A):
� __CONFIG _XT_OSC & _BODEN_OFF & ....

�� 例例:(:(PIC16F877A):PIC16F877A):
�� __CONFIG __CONFIG _XT_OSC & _BODEN_OFF & ...._XT_OSC & _BODEN_OFF & ....

Open the Processor Include file 
(*.INC) and scroll to end to see 

the configuration bit options

Open the Processor Include file Open the Processor Include file 
(*.(*.INCINC) and scroll to end to see ) and scroll to end to see 

the configuration bit optionsthe configuration bit options

Bitwise AND (&) together any 
desired terms                        

(may grow long on some parts)

Bitwise AND (Bitwise AND (&&) together any ) together any 
desired terms                        desired terms                        

(may grow long on some parts)(may grow long on some parts)
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使用 Watch Window使用使用 Watch WindowWatch Window

� View -> Watch
� 键入观察的 寄存器/变量

� 点击“Add SFR” 或 “Add Symbol”

�� View View --> Watch> Watch
�� 键入观察的键入观察的 寄存器寄存器//变量变量

�� 点击点击““Add SFRAdd SFR”” 或或 ““Add SymbolAdd Symbol””
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用MPLAB IDE调试用用MPLAB IDEMPLAB IDE调试调试

� MPLAB IDE 界面�� MPLAB IDE MPLAB IDE 界面界面

输出信息窗口

源代码窗口

工程项目窗口

变量观察窗口



© Microchip Technology Incorporated. All Rights Reserved.         701 PIC           701 PIC           PIC® MCU - Introduction to Programming          110

MPLAB IDE
快捷键

MPLAB IDEMPLAB IDE
快捷键快捷键

� -调试快捷键

� F5 Halt - 暂停

� F6 Reset - 复位

� F7 Step - 单步运行

� F9 Run - 全速运行

� 或使用 图标栏!

�� --调试快捷键调试快捷键

�� F5F5 HaltHalt -- 暂停暂停

�� F6F6 ResetReset -- 复位复位

�� F7F7 StepStep -- 单步运行单步运行

�� F9F9 RunRun -- 全速运行全速运行

�� 或使用或使用 图标栏图标栏!!
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Lab 2 – 注意Lab 2 Lab 2 –– 注意注意

� MPLAB IDE功能强大, 下列免费

� 编辑器

� 编译器

� 模拟器

� 与其它工具的接口

� 使用 Watch Windows 调试你的代码

� 编程前先设置 configuration bits 
� 跳转指令

� btfss, btfscc, incfsz, decfsz

�� MPLAB IDEMPLAB IDE功能强大功能强大, , 下列免费下列免费

�� 编辑器编辑器

�� 编译器编译器

�� 模拟器模拟器

�� 与其它工具的接口与其它工具的接口

�� 使用使用 Watch Windows Watch Windows 调试你的代码调试你的代码

�� 编程前先设置编程前先设置 configuration bits configuration bits 
�� 跳转指令跳转指令

�� btfssbtfss, , btfsccbtfscc, , incfszincfsz, , decfszdecfsz
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Lab 3
使用 CCP 模块

Lab 3Lab 3
使用使用 CCPCCP 模块模块
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Lab 3Lab 3Lab 3

� Lab 3 目标

� 介绍 CCP 和PWM 
� 让蜂鸣器鸣叫

�� Lab 3 Lab 3 目标目标

�� 介绍介绍 CCP CCP 和和PWM PWM 
�� 让蜂鸣器鸣叫让蜂鸣器鸣叫
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R            QR            Q

SS

Period (rate)Period (rate)

COMPARECOMPARE

((counter)counter)

COMPARECOMPARE

Lab 3: CCPLab 3: CCPLab 3: CCP

Note:Note:
These 2 bits can be These 2 bits can be ‘‘QQ’’ cylescyles,,

or the counter divided by 4or the counter divided by 4

Divide byDivide by
1, 4 or 161, 4 or 16

CCPR1L CCP1CON<5:4>

CCPR1H

TMR2

PR2

((copy)copy)

0000Duty_CycleDuty_Cycle

Fosc/4

OutputOutput

PrescalerPrescaler
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RateRate99

R            QR            Q

SS

COMPARECOMPARE

COMPARECOMPARE

Lab 3: CCPLab 3: CCPLab 3: CCP

Note:Note:
These 2 bits can be These 2 bits can be ‘‘QQ’’ cylescyles,,

or the counter divided by 4or the counter divided by 4

Divide byDivide by
1, 4 or 161, 4 or 16

CCPR1L CCP1CON<5:4>

CCPR1H

TMR2

PR2

Fosc/4

OutputOutput

PrescalerPrescaler

55Duty_CycleDuty_Cycle 0000

5           005           00

00((counter)counter)11223344556677889900

Transition at 5 due to match of Transition at 5 due to match of 
CCPR1x and TMR2CCPR1x and TMR2

Output goes low and TMR2 is Output goes low and TMR2 is 
reset after PR2 matches TMR2reset after PR2 matches TMR2



© Microchip Technology Incorporated. All Rights Reserved.         701 PIC           701 PIC           PIC® MCU - Introduction to Programming          116

Lab 3:
CCP 预分频

Lab 3:Lab 3:
CCP CCP 预分频预分频

Divide byDivide by
1, 4 or 161, 4 or 16

Fosc/4 PrescalerPrescaler � 使用TMR2 预分频�� 使用使用TMR2 TMR2 预分频预分频

� 例:  
� Fosc = 4 MHz
� Fcy = 1 MHz
� Tcy = 1 us

�� 例例:  :  
�� FoscFosc = 4 MHz= 4 MHz
�� FcyFcy = 1 MHz= 1 MHz
�� TcyTcy = 1 us= 1 us

0000
0101
11xx 1616

44
11

16.00 16.00 usus
4.00 4.00 usus
1.00 1.00 usus

T1CKPS1:0T1CKPS1:0 Divides byDivides by Count RateCount Rate
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Lab 3:
计算CCP 值

Lab 3:Lab 3:
计算计算CCP CCP 值值

� 例: 880 Hz( 4 MHz 的主晶振)

� 选择TMR2 预分频值 16
� 计算 PR2

� (4 MHz / 16) / 4 = 62500 Hz 
� 62500 Hz / 880 = 71.022727 - 1 = 70

� 计算 CCPR1L :
� 50% 的占空比 是35.

�� 例例:: 880 880 Hz( 4 MHz Hz( 4 MHz 的主晶振的主晶振))

�� 选择选择TMR2 TMR2 预分频值预分频值 1616
�� 计算计算 PR2PR2

�� (4 MHz / 16) / 4 = 62500 Hz (4 MHz / 16) / 4 = 62500 Hz 
�� 62500 Hz / 880 = 71.022727 62500 Hz / 880 = 71.022727 -- 1 = 1 = 7070

�� 计算计算 CCPR1LCCPR1L ::
�� 50% 50% 的占空比的占空比 是是3535..
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Lab 3:
问题

Lab 3:Lab 3:
问题问题

� 为何选择 16 作为预分频?
� 我们提前计算:
� 回忆 PR2 的结果(70 )
� 如果预分频选择4,

� 计算 PR2 :
� (4 MHz / 4) / 4 = 250000 Hz 

� 250000 Hz / 880 = 284.09 = 284 = >255

� 结果比之前的预分频值更糟

�� 为何选择为何选择 1616 作为预分频作为预分频??
�� 我们提前计算我们提前计算::
�� 回忆回忆 PR2 PR2 的结果的结果(70 (70 ))
�� 如果预分频选择如果预分频选择4,4,

�� 计算计算 PR2PR2 ::
�� (4 MHz / 4) / 4 = 250000 Hz (4 MHz / 4) / 4 = 250000 Hz 

�� 250000 Hz / 880 = 284.09 = 250000 Hz / 880 = 284.09 = 284 = >255284 = >255

�� 结果比之前的预分频值更糟结果比之前的预分频值更糟
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Lab 3: 内容Lab 3: Lab 3: 内容内容

� 设置PWM为 880Hz, 50% 占空比
� 这个频率可听得见, 计算:

� PR2 
� CCPR1L 

� 设置 T2CON 
� TMR2 用于 PWM 
� 选择TMR2 预分频

� RA4 按下鸣叫
� 在LAB 3基础上基于 RA4 输入进行跳转

� 设置CCP1CON 打开或 关闭PWM

� 用MPLAB SIM, MPLAB ICD2 , PICDEM 2 Plus验证调试

�� 设置设置PWMPWM为为 880880Hz, 50% Hz, 50% 占空比占空比

�� 这个频率可听得见这个频率可听得见, , 计算计算::
�� PR2 PR2 
�� CCPR1L CCPR1L 

�� 设置设置 T2CON T2CON 
�� TMR2 TMR2 用于用于 PWM PWM 
�� 选择选择TMR2 TMR2 预分频预分频

�� RA4 RA4 按下鸣叫按下鸣叫

�� 在在LAB 3LAB 3基础上基于基础上基于 RA4 RA4 输入进行跳转输入进行跳转

�� 设置设置CCP1CONCCP1CON 打开或打开或 关闭关闭PWMPWM

�� 用用MPLAB SIM, MPLAB ICD2 , PICDEM 2 PlusMPLAB SIM, MPLAB ICD2 , PICDEM 2 Plus验证调试验证调试
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LAB 3LAB 3LAB 3

� 让PIC16F877A发出音乐�� 让让PIC16F877APIC16F877A发出音乐发出音乐

#INCLUDE p16F877A.inc ; Include the standard definitions

Start
BANKSEL TRISC ; BANKSEL to get to TRISC bank (bank 1)
bcf TRISC,2 ; Set CCP1 as an output
movlw D'70' ; Manually Calculated Period
movwf PR2 ;  loaded into PR2 (also in bank1)
BANKSEL CCPR1L ; BANKSEL is needed to get bank to bank 0.
movlw D'35' ; Manually Calculated Duty Cycle (50%)
movwf CCPR1L ;  loaded into CCPR1L
movlw 0x06 ; Turn on TMR2 (for PWM) 
movwf T2CON ; and /16 prescale

##INCLUDE p16F877A.incINCLUDE p16F877A.inc ; Include the standard definitions; Include the standard definitions

StartStart
BANKSELBANKSEL TRISCTRISC ; BANKSEL to get to TRISC bank (bank 1); BANKSEL to get to TRISC bank (bank 1)
bcfbcf TRISC,2TRISC,2 ; Set CCP1 as an output; Set CCP1 as an output
movlwmovlw D'70'D'70' ; Manually Calculated Period; Manually Calculated Period
movwfmovwf PR2PR2 ;  loaded into PR2 (also in bank1);  loaded into PR2 (also in bank1)
BANKSELBANKSEL CCPR1LCCPR1L ; BANKSEL is needed to get bank to bank 0.; BANKSEL is needed to get bank to bank 0.
movlwmovlw D'35'D'35' ; Manually Calculated Duty Cycle (50%); Manually Calculated Duty Cycle (50%)
movwfmovwf CCPR1LCCPR1L ;  loaded into CCPR1L;  loaded into CCPR1L
movlwmovlw 0x060x06 ; Turn on TMR2 (for PWM) ; Turn on TMR2 (for PWM) 
movwfmovwf T2CONT2CON ; and /16 ; and /16 prescaleprescale
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LAB 3LAB 3LAB 3

CheckButton
btfsc PORTA,4 ; Test the button - if pressed, its a low signal. 
goto ButtonOff ; if high (not pressed), go to “Button Off” code

ButtonOn
movlw H'0C’ ; if low (pressed), fall here to “Button On” code.
movwf CCP1CON ; this turns on CCP1CON by writing 0C (hex) to it.
goto CheckButton ; go check the button again (back to CheckButton)

ButtonOff
clrf CCP1CON ; Turn off CCP1 module by writing 0 to it
goto CheckButton ; go check the button again (back to CheckButton)
END ; All programs must have an END directive

CheckButtonCheckButton
btfscbtfsc PORTA,4PORTA,4 ; Test the button ; Test the button -- if pressed, its a low signal. if pressed, its a low signal. 
gotogoto ButtonOffButtonOff ; if high (not pressed), go to ; if high (not pressed), go to ““Button OffButton Off”” codecode

ButtonOnButtonOn
movlwmovlw H'0CH'0C’’ ; if low (pressed), fall here to ; if low (pressed), fall here to ““Button OnButton On”” code.code.
movwfmovwf CCP1CONCCP1CON ; this turns on CCP1CON by writing 0C (hex) to it.; this turns on CCP1CON by writing 0C (hex) to it.
gotogoto CheckButtonCheckButton ; go check the button again (back to ; go check the button again (back to CheckButtonCheckButton))

ButtonOffButtonOff
clrfclrf CCP1CONCCP1CON ; Turn off CCP1 module by writing 0 to it; Turn off CCP1 module by writing 0 to it
gotogoto CheckButtonCheckButton ; go check the button again (back to ; go check the button again (back to CheckButtonCheckButton))
ENDEND ; All programs must have an END directive; All programs must have an END directive
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Lab 3 – 提高Lab 3 Lab 3 –– 提高提高

� 尝试一下!
� 尝试改变频率. 能改变成440 Hz?

� 计算:
� Timer 2 预分频值(1,4 or 16)
� PR2 值, 然后减 1
� CCPR1L 值

� 测试:
� 使用 ‘ICD 2 and F7, F5进行调试.

�� 尝试一下尝试一下!!
�� 尝试改变频率尝试改变频率. . 能改变成能改变成440 Hz440 Hz??

�� 计算计算::
�� Timer 2 Timer 2 预分频值预分频值(1,4 (1,4 or 16)or 16)
�� PR2 PR2 值值, , 然后减然后减 11
�� CCPR1L CCPR1L 值值

�� 测试测试::
�� 使用使用 ‘‘ICD 2 and F7, F5ICD 2 and F7, F5进行调试进行调试..



© Microchip Technology Incorporated. All Rights Reserved.         701 PIC           701 PIC           PIC® MCU - Introduction to Programming          123

休息 (II)休息休息 ((IIII))
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Lab 4

使用 A/D Converter        
(PIC16F877A)

Lab 4Lab 4

使用使用 A/D Converter        A/D Converter        
(PIC16F877A)(PIC16F877A)
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Lab 4目标Lab 4Lab 4目标目标

� Lab 4 目标

� A/D Converter 在 PIC16F877A执行A/D转换

� 基于模拟输入点亮 LEDs
� 学习使用宏命令

�� Lab 4 Lab 4 目标目标

�� A/D Converter A/D Converter 在在 PIC16F877APIC16F877A执行执行A/DA/D转换转换

�� 基于模拟输入点亮基于模拟输入点亮 LEDsLEDs
�� 学习使用宏命令学习使用宏命令
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A/DA/DA/D

� 使用 A/D
� 设置口方向(TRISx )
� 设置模拟和数字通道(ADCON1 或 ANSEL)
� 设置A/D 时钟 (ADCON0 / ADCON1)
� 执行转换循环

�� 使用使用 A/DA/D
�� 设置口方向设置口方向((TRISxTRISx ))
�� 设置模拟和数字通道设置模拟和数字通道((ADCON1ADCON1 或或 ANSELANSEL))
�� 设置设置A/D A/D 时钟时钟 ((ADCON0ADCON0 / / ADCON1ADCON1))
�� 执行转换循环执行转换循环
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A/DA/DA/D

� 设置 A/D 
� 时钟 ADCON0

(内部RC 或 Fosc ) ADCON1
� 通道 (AN0, AN7) ADCON0
� 打开A/D (ADON 置1) ADCON0
� 设置参考电压 (VDD 或外部.) ADCON1
� 选择对齐 ADCON1

�� 设置设置 A/D A/D 
�� 时钟时钟 ADCON0ADCON0

((内部内部RC RC 或或 FoscFosc )) ADCON1ADCON1
�� 通道通道 ((AN0, AN7)AN0, AN7) ADCON0ADCON0
�� 打开打开A/D (ADON A/D (ADON 置置1)1) ADCON0ADCON0
�� 设置参考电压设置参考电压 ((VVDDDD 或外部或外部.).) ADCON1ADCON1
�� 选择对齐选择对齐 ADCON1ADCON1
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设置 TRISx设置设置 TRISxTRISx

� 设置口方向
� 通过TRISA, TRISE设置为输入或输出. 
� 相关的模拟口必须为输入.

�� 设置口方向设置口方向

�� 通过通过TRISATRISA, , TRISETRISE设置为输入或输出设置为输入或输出. . 
�� 相关的模拟口必须为输入相关的模拟口必须为输入..
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A/DA/DA/D

� 设置模拟和数字通道

� 必须设置口为数字或模拟口

� 通过ADCON1和ANSEL来设置

�� 设置模拟和数字通道设置模拟和数字通道

�� 必须设置口为数字或模拟口必须设置口为数字或模拟口

�� 通过通过ADCON1ADCON1和和ANSELANSEL来设置来设置

00000000

00010001
00100010 DD

AA
AA

PCFG<3:0>PCFG<3:0> AN7AN7

DD
AA
AA

AN6AN6

DD
AA
AA

AN5AN5

AA
AA
AA

AN4AN4

AA

VrefVref++

AA

AN3AN3

AA
AA
AA

AN2AN2

AA
AA
AA

AN1AN1

AA
AA
AA

AN0AN0

VVDDDD

AN3AN3
VVDDDD

VrefVref++

VssVss
VssVss
VssVss

VrefVref--

55//00
77//11
88//00

C/RC/R

This chart is a sample of modes, there are 15 modes for this part

We will be using mode 1110 (1 A/D channel, VDD and VSS reference)
11101110 DD DD DD DD DD DD DD AA VddVdd VssVss 11//00

Voltage ReferencesVoltage ReferencesChannel Mode OptionsChannel Mode OptionsBit SettingBit Setting
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A/DA/DA/D

� 选择 参考电源

� 参考电源可为 VDD VSS 或外接

� 当设置数字和模拟引脚模式时同时设置

�� 选择选择 参考电源参考电源

�� 参考电源可为参考电源可为 VVDD DD VVSSSS 或外接或外接

�� 当设置数字和模拟引脚模式时同时设置当设置数字和模拟引脚模式时同时设置

PCFG<3:0>PCFG<3:0> AN7AN7 AN6AN6 AN5AN5 AN4AN4 AN3AN3 AN2AN2 AN1AN1 AN0AN0 VrefVref++ VrefVref-- C/RC/R
11101110 DD DD DD DD DD DD DD AA VVDDDD VssVss 11//00

Voltage ReferencesVoltage ReferencesChannel Mode OptionsChannel Mode OptionsBit SettingBit Setting

高参考源高参考源

A/D A/D 通道通道 //
参考输入参考输入

低参考源低参考源
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A/DA/DA/D

� 设置 A/D 时钟

� 两个主要选项- 内部RC 和 Fosc
� Fosc 有许多分频选项

� 内部RC 是独立的 A/D 振荡器

� ADCON0 (有时 ADCON1) 设置 A/D 时钟

�� 设置设置 A/D A/D 时钟时钟

�� 两个主要选项两个主要选项-- 内部内部RC RC 和和 FoscFosc
�� FoscFosc 有许多分频选项有许多分频选项

�� 内部内部RC RC 是独立的是独立的 A/D A/D 振荡器振荡器

�� ADCON0ADCON0 ((有时有时 ADCON1ADCON1) ) 设置设置 A/D A/D 时钟时钟
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A/DA/DA/D

� A/D 时钟计算

� 假设 4 MHz 主频, PIC18F877A
� 则Tosc = 250 ns

� TAD 必须 1.6 us 到20 us

�� A/D A/D 时钟计算时钟计算

�� 假设假设 4 4 MHz MHz 主频主频, , PIC18F877APIC18F877A
�� 则则ToscTosc = 250 ns= 250 ns

�� TTADAD 必须必须 1.6 1.6 us us 到到20 20 usus

00
00
00

ADCON1 <ADCS2>ADCON1 <ADCS2>

Fosc/32Fosc/32
Fosc/8Fosc/8
Fosc/2Fosc/2

ClockClock
ModeMode

Bit SettingBit Setting

0000
0101
1010

ADCON0 <ADCS1:0>ADCON0 <ADCS1:0>

11
11
11 Fosc/64Fosc/64

Fosc/16Fosc/16
Fosc/4Fosc/40000

0101
1010

xx FFRC RC (internal RC)(internal RC)1111

250 ns / 1.6 us = 1/6.4250 ns / 1.6 us = 1/6.4

因此选择因此选择Fosc/8 Fosc/8 
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A/DA/DA/D

� 选择对齐

� 结果是10 位宽

� 结果存于: ADRESH ,ADRESL

�� 选择对齐选择对齐

�� 结果是结果是10 10 位宽位宽

�� 结果存于结果存于: : ADRESHADRESH ,,ADRESLADRESL

bbbbbbbb bbbbbbbb bbbb0000 00000000 0000 000000 00bbbb bbbbbbbb bbbbbbbb
左对齐左对齐 右对齐右对齐

� 打开 A/D
� ADCON0的ADON位置1

�� 打开打开 A/DA/D
�� ADCON0ADCON0的的ADONADON位置位置11

ADRESH     ADRESLADRESH     ADRESL ADRESH     ADRESLADRESH     ADRESL
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A/DA/DA/D

� 循环转换
� 插入取样时间 (你的代码)
� 开始转换 (GO/DONE置1)
� 等待GO/DONE 清零 (或ADIF=1)
� 读A/D 值(ADRESH / ADRESL)

�� 循环转换循环转换
�� 插入取样时间插入取样时间 ((你的代码你的代码))
�� 开始转换开始转换 ((GO/DONEGO/DONE置置1)1)
�� 等待等待GO/DONE GO/DONE 清零清零 ((或或ADIF=1)ADIF=1)
�� 读读A/D A/D 值值((ADRESH / ADRESL)ADRESH / ADRESL)

取样时间取样时间 ADAD转换转换通道选择通道选择

如果为多通道输入如果为多通道输入

选择通道选择通道 置置 GO/DONE GO/DONE 位位 PICPIC清除清除GO/DONE GO/DONE 位位

ADRESH     ADRESLADRESH     ADRESL
你的你的A/DA/D结果结果
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宏命令宏命令宏命令

� 宏命令

� 用MACRO开始 ,用ENDM结束

Name_Of_Macro MACRO Variables
nop ;My Code Goes Here

ENDM

�� 宏命令宏命令

�� 用用MACROMACRO开始开始 ,,用用ENDMENDM结束结束

Name_Of_MacroName_Of_Macro MACROMACRO VariablesVariables
nopnop ;My Code Goes Here;My Code Goes Here

ENDMENDM
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宏命令宏命令宏命令

� 宏命令
例:
AddW MACRO Input
addlw Input

ENDM

你的代码中:
AddW 5 ; Add 5 to W

�� 宏命令宏命令

例例::
AddWAddW MACROMACRO InputInput
addlwaddlw InputInput

ENDMENDM

你的代码中你的代码中::
AddWAddW 55 ; Add 5 to W; Add 5 to W
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Lab 4: 内容Lab 4: Lab 4: 内容内容

� 读 A/D值,用 ADRESH 值点亮 LEDs
� 当值小于 100

� 点亮 LED 0 和关闭 LED 1
� 当值大于 100

� 点亮 LED 1 和关闭 LED 0

� 别忘了取样时间
� GO/DONE 置1前必须延时, 1 ms足够

� 例: Dly32 D’50’ 延时1 ms

�� 读读 A/DA/D值值,,用用 ADRESH ADRESH 值点亮值点亮 LEDsLEDs
�� 当值小于当值小于 100100

�� 点亮点亮 LED 0 LED 0 和关闭和关闭 LED 1LED 1
�� 当值大于当值大于 100100

�� 点亮点亮 LED 1 LED 1 和关闭和关闭 LED 0LED 0

�� 别忘了取样时间别忘了取样时间
�� GO/DONE GO/DONE 置置11前必须延时前必须延时, 1 , 1 msms足够足够

�� 例例: : Dly32 DDly32 D’’5050’’ 延时延时1 1 msms
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Lab 4:宏命令Lab 4:Lab 4:宏命令宏命令

� 可使用下列宏命令:
� LEDEnable <bitpattern>

� 1 输入, 0 输出.  
� 允许LED 0 和 1, 使用:

� LEDEnable B’11111100’ or LEDEnable
H’FC’

� LEDOn <LED number>
� <LED number>必须在0和3之间.  
� 例, 点亮 LED 0

� LEDOn 0

�� 可使用下列宏命令可使用下列宏命令::
�� LEDEnableLEDEnable <<bitpatternbitpattern>>

�� 1 1 输入输入, 0 , 0 输出输出.  .  
�� 允许允许LED 0 LED 0 和和 1, 1, 使用使用::

�� LEDEnableLEDEnable BB’’1111110011111100’’ or or LEDEnableLEDEnable
HH’’FCFC’’

�� LEDOnLEDOn <<LED numberLED number>>
�� <LED number><LED number>必须在必须在00和和33之间之间.  .  
�� 例例, , 点亮点亮 LED 0LED 0

�� LEDOnLEDOn 00
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Lab 4:宏命令Lab 4:Lab 4:宏命令宏命令

� LEDOff <LED number>
� LEDOff 关闭 LED
� 例

� LEDOff 2

� Dly32 <Cycles x 20>
� 延时子程序

� 例延时 1 ms (1000 cycles at 4 MHz) :
� Dly32 D’50’ ; Delay of 50 x 20 cycles = 1000 Tcy

�� LEDOffLEDOff <<LED numberLED number>>
�� LEDOffLEDOff 关闭关闭 LEDLED
�� 例例

�� LEDOffLEDOff 22

�� Dly32 Dly32 <<Cycles x 20Cycles x 20>>
�� 延时子程序延时子程序

�� 例延时例延时 1 1 ms (1000 cycles at 4 MHz) :ms (1000 cycles at 4 MHz) :
�� Dly32Dly32 DD’’5050’’ ; Delay of 50 x 20 cycles = 1000 ; Delay of 50 x 20 cycles = 1000 TcyTcy
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LAB 4LAB 4LAB 4

#INCLUDE p16F877A.inc ; Include the standard definitions
#INCLUDE 701PIC.inc ; Include MACROs from MASTER’s 03, PIC 102 class
#DEFINE TESTVAL D’100’ ; High Value to compare A/D reading against

Start
LEDEnable B’11111100’ ; MACRO to setup I/O port to drive LEDs RB1 and RB0
BANKSEL TRISA ; BANKSEL to TRISA in bank 1
movlw H’01’ ; Initialize PORTA so that RA0 (analog channel 0) is an input,
movwf TRISA ; all other PORTA pins are outputs
movlw H’0E’ ; Initialize the A/D to be analog on, partly selects clock mode
movwf ADCON1 ;  channel 0 (RA0), all other pins are digital mode
BANKSEL ADCON0 ; BANKSEL to ADCON0 in bank 0
movlw H’41’ ; Also, A/D clock is Fosc/8 (good for up to 5 MHz, 5V) and,
movwf ADCON0 ; A/D is turned on but not yet converting and ready on Ch 0.

CheckAgain
Dly32 D’50’ ; MACRO to Wait 1 ms (at 4 MHz)
bsf ADCON0,GO ; Start the Conversion

##INCLUDE p16F877A.incINCLUDE p16F877A.inc ; Include the standard definitions; Include the standard definitions
#INCLUDE 701PIC.inc#INCLUDE 701PIC.inc ; Include ; Include MACROsMACROs from from MASTERMASTER’’ss 03, PIC 102 class03, PIC 102 class
#DEFINE#DEFINE TESTVALTESTVAL DD’’100100’’ ; High Value to compare A/D reading against; High Value to compare A/D reading against

StartStart
LEDEnableLEDEnable BB’’1111110011111100’’ ; MACRO to setup I/O port to drive ; MACRO to setup I/O port to drive LEDsLEDs RB1 and RB0RB1 and RB0
BANKSELBANKSEL TRISATRISA ; BANKSEL to TRISA in bank 1; BANKSEL to TRISA in bank 1
movlwmovlw HH’’0101’’ ; Initialize PORTA so that RA0 (analog channel 0) is an input,; Initialize PORTA so that RA0 (analog channel 0) is an input,
movwfmovwf TRISATRISA ; all other PORTA pins are outputs; all other PORTA pins are outputs
movlwmovlw HH’’0E0E’’ ; Initialize the A/D to be analog on, partly selects clock mode; Initialize the A/D to be analog on, partly selects clock mode
movwfmovwf ADCON1ADCON1 ;  channel 0 (RA0), all other pins are digital mode;  channel 0 (RA0), all other pins are digital mode
BANKSELBANKSEL ADCON0ADCON0 ; BANKSEL to ADCON0 in bank 0; BANKSEL to ADCON0 in bank 0
movlwmovlw HH’’4141’’ ; Also, A/D clock is Fosc/8 (good for up to 5 MHz, 5V) and,; Also, A/D clock is Fosc/8 (good for up to 5 MHz, 5V) and,
movwfmovwf ADCON0ADCON0 ; A/D is turned on but not yet converting and ready on Ch 0.; A/D is turned on but not yet converting and ready on Ch 0.

CheckAgainCheckAgain
Dly32Dly32 DD’’5050’’ ; MACRO to Wait 1 ms (at 4 MHz); MACRO to Wait 1 ms (at 4 MHz)
bsfbsf ADCON0,GOADCON0,GO ; Start the Conversion; Start the Conversion
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LAB 4LAB 4LAB 4

PollAD
btfsc ADCON0,GO ; Wait for Conversion to finish
goto PollAD ; go back and poll the A/D GO/DONE bit again

ConvertDone
movf ADRESH,W ; Move A/D result (high byte) into W for later testing
sublw TESTVAL ; Test A/D result against test value
btfss STATUS,C ; go to “over” if A/D result larger than test value
goto Over ; value is too large, run “Over” code

Ok
LEDOn 0 ; MACRO to turn on LED 0
LEDOff 1 ; MACRO to turn off LED 1 (this shows “Ok” condition)
goto CheckAgain ; Do A/D read and value test over again

Over
LEDOn 1 ; MACRO to turn on LED 1
LEDOff 0 ; MACRO to turn off LED 0 (this shows “Over” condition)
goto CheckAgain ; Do A/D read and value test over again
END

PollADPollAD
btfscbtfsc ADCON0,GOADCON0,GO ; Wait for Conversion to finish; Wait for Conversion to finish
gotogoto PollADPollAD ; go back and poll the A/D GO/DONE bit again; go back and poll the A/D GO/DONE bit again

ConvertDoneConvertDone
movfmovf ADRESH,WADRESH,W ; Move A/D result (high byte) into W for later testing; Move A/D result (high byte) into W for later testing
sublwsublw TESTVALTESTVAL ; Test A/D result against test value; Test A/D result against test value
btfssbtfss STATUS,CSTATUS,C ; go to ; go to ““overover”” if A/D result larger than test valueif A/D result larger than test value
gotogoto OverOver ; value is too large, run ; value is too large, run ““OverOver”” codecode

OkOk
LEDOnLEDOn 00 ; MACRO to turn on LED 0; MACRO to turn on LED 0
LEDOffLEDOff 11 ; MACRO to turn off LED 1 (this shows ; MACRO to turn off LED 1 (this shows ““OkOk”” condition)condition)
gotogoto CheckAgainCheckAgain ; Do A/D read and value test over again; Do A/D read and value test over again

OverOver
LEDOnLEDOn 11 ; MACRO to turn on LED 1; MACRO to turn on LED 1
LEDOffLEDOff 00 ; MACRO to turn off LED 0 (this shows ; MACRO to turn off LED 0 (this shows ““OverOver”” condition)condition)
gotogoto CheckAgainCheckAgain ; Do A/D read and value test over again; Do A/D read and value test over again
ENDEND
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Lab 4 – 警示灯Lab 4 Lab 4 –– 警示灯警示灯

� 试一试!
� 调节电位器RA0. LEDs 改变吗?

�� 试一试试一试!!
�� 调节电位器调节电位器RA0. RA0. LEDsLEDs 改变吗改变吗??
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Lab 4b – 报警!Lab 4b Lab 4b –– 报警报警!!

� 尝试下列功能:
� 复制Lab 4 代码粘贴到 Lab 

5.

� 如果值大于 “TESTVAL”鸣叫

� 使用GOTO or 
CALL/RETURN 指令

�� 尝试下列功能尝试下列功能::
�� 复制复制Lab 4 Lab 4 代码粘贴到代码粘贴到 Lab Lab 

5.5.

�� 如果值大于如果值大于 ““TESTVALTESTVAL””鸣叫鸣叫

�� 使用使用GOTO or GOTO or 
CALL/RETURN CALL/RETURN 指令指令

Lab 4 (Beep)Lab 4 (Beep)Lab 4 (Beep)

Lab 5 (A/D Test)Lab 5 (A/D Test)Lab 5 (A/D Test)

ButtonOn (start beeping)ButtonOnButtonOn (start beeping)(start beeping)

OverOverOver

ButtonOff (stop beeping)ButtonOffButtonOff (stop beeping)(stop beeping)

OkOkOk

New Lab 5New Lab 5New Lab 5
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Lab 5
定时器及中断
(on the PIC16F877A)

Lab 5Lab 5

定时器及中断定时器及中断
((on the PIC16F877A)on the PIC16F877A)
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Lab 5的目标Lab 5Lab 5的目标的目标

� Lab 5 的目标

� 学习TMR0
� 理解查询和中断

� 写一个基于中断的延时程序

� LED 以中断设定的速度闪烁

�� Lab 5 Lab 5 的目标的目标

�� 学习学习TMR0TMR0
�� 理解查询和中断理解查询和中断

�� 写一个基于中断的延时程序写一个基于中断的延时程序

�� LED LED 以中断设定的速度闪烁以中断设定的速度闪烁
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Lab 5:
TMR0 外设

Lab 5:Lab 5:
TMR0 TMR0 外设外设

� 可读写

� 从 FF 到 00 (hex)溢出时产生中断

� 预分频可选择 2, 4, 8, 16... 直到 256
� 定时模式: 最快速度是 OSC/4 (对于 20 MHz 晶振来说是5 MHz)
� 外部事件计数模式: 上升沿或下降沿触发可供选择

� TMR0 位宽是8

�� 可读写可读写

�� 从从 FF FF 到到 00 (00 (hex)hex)溢出时产生中断溢出时产生中断

�� 预分频可选择预分频可选择 2, 4, 8, 16... 2, 4, 8, 16... 直到直到 256256
�� 定时模式定时模式: : 最快速度是最快速度是 OSC/4 (OSC/4 (对于对于 20 20 MHz MHz 晶振来说是晶振来说是5 MHz5 MHz))
�� 外部事件计数模式外部事件计数模式: : 上升沿或下降沿触发可供选择上升沿或下降沿触发可供选择

�� TMR0 TMR0 位宽是位宽是88

Ext clockExt clock
inputinput

InternalInternal
clock (clock (TcyTcy))

88--bit timer/counterbit timer/counter

TMR0IFTMR0IF
overflow flag outputoverflow flag output

预分频预分频

Divide byDivide by
1, 4 or 161, 4 or 16
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使用 TMR0使用使用 TMR0TMR0
� TMR0 时钟源是 Fosc / 4

� 您的Demo板上使用 4 MHz 时钟 (Fosc)

� 当使用预分频时, 输入可进一步除上 2, 4, 8, 
16... 直到 256.

� TMR0 从 00 到 FF (hex)向上计数, 计到FF时
溢出从00开始重新计数.

� 溢出时标志位置1以供中断或查询使用.

�� TMR0 TMR0 时钟源是时钟源是 FoscFosc / 4/ 4
�� 您的您的DemoDemo板上使用板上使用 4 4 MHzMHz 时钟时钟 ((FoscFosc))

�� 当使用预分频时当使用预分频时, , 输入可进一步除上输入可进一步除上 2, 4, 8, 2, 4, 8, 
16... 16... 直到直到 256256..

�� TMR0 TMR0 从从 00 00 到到 FF (hex)FF (hex)向上计数向上计数, , 计到计到FFFF时时
溢出从溢出从0000开始重新计数开始重新计数..

�� 溢出时标志位置溢出时标志位置11以供中断或查询使用以供中断或查询使用..
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计算 TMR0 的溢出计算计算 TMR0 TMR0 的溢出的溢出

� 使用 4 MHz 时钟

� TMR0 计数时钟速率是 Fosc/4
� 对于一 200 ms (0.2 second)速率中断,

� 您将如何配置 TMR0 的预分频?
� TMR0 初值置多少?

� 考虑:
� 计数器以1 us速率计数, 无预分频, 能计到多少?
� Time = 预分频 x maximum count (8 bits) x rate
� Time = 256 x 256 x 1 us
� Time = 65536
� 但我们需 200000 来得到 0.2 秒!

�� 使用使用 4 4 MHzMHz 时钟时钟

�� TMR0 TMR0 计数时钟速率是计数时钟速率是 Fosc/4Fosc/4
�� 对于一对于一 200 200 ms (0.2 second)ms (0.2 second)速率中断速率中断,,

�� 您将如何配置您将如何配置 TMR0 TMR0 的预分频的预分频??
�� TMR0TMR0 初值置多少初值置多少??

�� 考虑考虑::
�� 计数器以计数器以1 1 usus速率计数速率计数, , 无预分频无预分频, , 能计到多少能计到多少??
�� Time = Time = 预分频预分频 x maximum count (8 bits) x ratex maximum count (8 bits) x rate
�� Time = 256 x 256 x 1 usTime = 256 x 256 x 1 us
�� Time = Time = 6553665536
�� 但我们需但我们需 200000 200000 来得到来得到 0.2 0.2 秒秒!!
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计算 TMR0 的溢出
(第二部分)

计算计算 TMR0 TMR0 的溢出的溢出
((第二部分第二部分))

� 将溢出时间作为计数单元

� 本例 50000 us
� 以整数的倍数 (4)计数来得到总时间.
� 这种设定中能计到50000 us吗？

� 除数是 (256), 时间 (50000) 得到商:
� 500000 / 256 = 195.3125 counts

� 选择:
� 忽略相对较小的误差 (195 * 256 = 49920 us)
� 改变主晶振以得到整数

� 改变除数, 获得快中断等诸多方法.

�� 将溢出时间作为计数单元将溢出时间作为计数单元

�� 本例本例 50000 50000 usus
�� 以整数的倍数以整数的倍数 (4)(4)计数来得到总时间计数来得到总时间..
�� 这种设定中能计到这种设定中能计到50000 us50000 us吗？吗？

�� 除数是除数是 (256), (256), 时间时间 (50000) (50000) 得到商得到商::
�� 500000 / 256 = 500000 / 256 = 195195..31253125 countscounts

�� 选择选择::
�� 忽略相对较小的误差忽略相对较小的误差 (195 * 256 = 49920 (195 * 256 = 49920 us)us)
�� 改变主晶振以得到整数改变主晶振以得到整数

�� 改变除数改变除数, , 获得快中断等诸多方法获得快中断等诸多方法..
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计算 TMR0 的溢出
(第三部分)

计算计算 TMR0 TMR0 的溢出的溢出
((第三部分第三部分))

� 本例中我们采用忽略误差的方法, 当然在您的应用中
方法会不一样

� 故, 这里TMR0是:
� 256 预分频 速率

� 195 计数值

� 4 个溢出

� 这样, 我们需给定时器预装一个初值，定时器从该值开始
向上计到256时，给出溢出信号:
� 这个值是 256 - 195 = 61

�� 本例中我们采用忽略误差的方法本例中我们采用忽略误差的方法, , 当然在您的应用中当然在您的应用中
方法会不一样方法会不一样

�� 故故, , 这里这里TMR0TMR0是是::
�� 256 256 预分频预分频 速率速率

�� 195 195 计数值计数值

�� 4 4 个溢出个溢出

�� 这样这样, , 我们需给定时器预装一个初值，定时器从该值开始我们需给定时器预装一个初值，定时器从该值开始
向上计到向上计到256256时，给出溢出信号时，给出溢出信号::
�� 这个值是这个值是 256 256 -- 195 = 61195 = 61
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TMR0 中断TMR0 TMR0 中断中断

� 当定时器溢出时, 会将标志位置1
� 举个例子, TMR0 将TMR0IF置1

� 中断 标志位 xxIF产生标志时，既可用来查询，同时
也是中断产生的基础

� 在您的软件中一旦检测到xxIF标志位，必须清零

�� 当定时器溢出时当定时器溢出时, , 会将标志位置会将标志位置11
�� 举个例子举个例子, , TMR0TMR0 将将TMR0IFTMR0IF置置11

�� 中断中断 标志位标志位 xxxxIFIF产生标志时，既可用来查询，同时产生标志时，既可用来查询，同时
也是中断产生的基础也是中断产生的基础

�� 在您的软件中在您的软件中一旦检测到一旦检测到xxxxIFIF标志位，标志位，必须清零必须清零
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Lab 5 - 中断Lab 5 Lab 5 -- 中断中断

� 中断...
� 使 CPU在执行主程序时转而执行其他任务

� 中断源有多种:
� 定时器

� 外设

� 外部信号

� 配置方式
� NTCON 寄存器

� 其他寄存器(随芯片不同而不同 – 详见数据手册)

�� 中断中断......
�� 使使 CPUCPU在执行主程序时转而执行其他任务在执行主程序时转而执行其他任务

�� 中断源有多种中断源有多种::
�� 定时器定时器

�� 外设外设

�� 外部信号外部信号

�� 配置方式配置方式
�� NTCONNTCON 寄存器寄存器

�� 其他寄存器其他寄存器((随芯片不同而不同随芯片不同而不同 –– 详见数据手册详见数据手册))
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中断中断中断

RBIF
RBIE

T0IF
T0IE

INTF
INTE

GIE

EEIE

唤醒

(如果在 SLEEP模式)

到CPU的中断

EEIF

Note:Note: There is often a There is often a ““PEIEPEIE”” bit which enables/disable further bit which enables/disable further 中断中断 sourcessources
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INTCON REG
PIC16F877A

R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-0 R/W-x

GIE PEIE T0IE INTE RBIE T0IF INTF RBIF R= Readable bit W= Writable bit
U= Unimplemented bit, read as ‘0’
- n= Value at POR reset

bit7 bit0

bit 7: GIE: Global 中断 Enable bit
1 = Enables all un-masked 中断
0 = Disables all 中断

bit 5: T0IE : TMR0 Overflow 中断 Enable bit
1 = Enables the TMR0 中断
0 = Disables the TMR0 中断

bit 2: T0IF : TMR0 Overflow 中断 Flag bit
1 = TMR0 has overflowed (must be cleared in software)
0 = TMR0 did not overflow
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为什么要用 中断?为什么要用为什么要用 中断中断??

� 更好的利用 CPU 资源

� 快速响应

� 多任务

� 固定的或已知的间隔处理

� 异常处理

�� 更好的利用更好的利用 CPU CPU 资源资源

�� 快速响应快速响应

�� 多任务多任务

�� 固定的或已知的间隔处理固定的或已知的间隔处理

�� 异常处理异常处理
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我需要中断吗?我需要中断吗我需要中断吗??

� 许多程序不需中断

� 逻辑流程中不用中断

� 不需现场保护...

�� 许多程序不需中断许多程序不需中断

�� 逻辑流程中不用中断逻辑流程中不用中断

�� 不需现场保护不需现场保护......



© Microchip Technology Incorporated. All Rights Reserved.         701 PIC           701 PIC           PIC® MCU - Introduction to Programming          157

中断:
ISR 现场保护

中断中断::
ISR ISR 现场保护现场保护

Push MACRO ; PUSH W and STATUS
movwf W_TEMP ; 
movf STATUS,W ; (swapf will also work here)
movwf STATUS_TEMP ;
ENDM

Push MACROPush MACRO ; PUSH W and STATUS; PUSH W and STATUS
movwfmovwf W_TEMPW_TEMP ; ; 
movfmovf STATUS,WSTATUS,W ; (; (swapfswapf will also work here)will also work here)
movwfmovwf STATUS_TEMPSTATUS_TEMP ;;
ENDMENDM

Pop MACRO ; POP W and STATUS
movf STATUS_TEMP,W ; (swapf will also work here)
movwf STATUS ;
swapf W_TEMP,F ; movf changes STATUS bit Z, but 
swapf W_TEMP,W ; swapf does not change STATUS
ENDM

Pop MACROPop MACRO ; POP W and STATUS; POP W and STATUS
movfmovf STATUS_TEMP,WSTATUS_TEMP,W ; (; (swapfswapf will also work here)will also work here)
movwfmovwf STATUSSTATUS ;;
swapfswapf W_TEMP,FW_TEMP,F ; ; movfmovf changes STATUS bit Z, but changes STATUS bit Z, but 
swapfswapf W_TEMP,WW_TEMP,W ; ; swapfswapf does not change STATUSdoes not change STATUS
ENDMENDM

RestoringRestoringRestoring

SavingSavingSaving
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Saving WSaving WSaving STATUSSaving STATUS

XXXX

1212 XXXX

Push MACRO ; PUSH W and STATUS
movwf W_TEMP ; 
movf STATUS,W ; (swapf will also work here)
movwf STATUS_TEMP ;
ENDM

Push MACROPush MACRO ; PUSH W and STATUS; PUSH W and STATUS
movwfmovwf W_TEMPW_TEMP ; ; 
movfmovf STATUS,WSTATUS,W ; (; (swapfswapf will also work here)will also work here)
movwfmovwf STATUS_TEMPSTATUS_TEMP ;;
ENDMENDM

中断:
ISR 现场保护

中断中断::
ISR ISR 现场保护现场保护

W

STATUS

W_TEMP

STATUS_TEMP

movwfmovwf W_TEMPW_TEMP
movfmovf STATUS,WSTATUS,W
movwfmovwf STATUS_TEMPSTATUS_TEMP

3434

1212

3434

3434
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Restoring STATUSRestoring STATUSRestoring WRestoring W

1212

Pop MACRO ; POP W and STATUS
movf STATUS_TEMP,W ; (swapf will also work here)
movwf STATUS ;
swapf W_TEMP,F ; movf changes STATUS bit Z, but 
swapf W_TEMP,W ; swapf does not change STATUS
ENDM

Pop MACROPop MACRO ; POP W and STATUS; POP W and STATUS
movfmovf STATUS_TEMP,WSTATUS_TEMP,W ; (; (swapfswapf will also work here)will also work here)
movwfmovwf STATUSSTATUS ;;
swapfswapf W_TEMP,FW_TEMP,F ; ; movfmovf changes STATUS bit Z, but changes STATUS bit Z, but 
swapfswapf W_TEMP,WW_TEMP,W ; ; swapfswapf does not change STATUSdoes not change STATUS
ENDMENDM

中断:
ISR现场保护

中断中断::
ISRISR现场保护现场保护

W

STATUS

W_TEMP

STATUS_TEMP

movfmovf STATUS_TEMP,WSTATUS_TEMP,W
movwfmovwf STATUSSTATUS
swapfswapf W_TEMP,FW_TEMP,F

XXXX 3434

swapfswapf W_TEMP,WW_TEMP,W

XXXX3434

3434

21211212
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Lab 5: 内容Lab 5: Lab 5: 内容内容

� TMR0 预分频 256, 每个循环计195 次以产生0.05 秒
(50000 us) 中断
� 每四个循环 (0.2 seconds) 触发LED 0.

� LED 0 (RB0)以此速率闪烁
� 在改变LED状态前你要读它的当前状态, 或采用其他方式

� 对该口写一完整的值,不对该口寄存器使用 bsf/bcf指令

� 使用 MPLAB SIM, MPLAB ICD2 以及 PICDEM 2 
Plus验证你的结果

�� TMR0 TMR0 预分频预分频 256256, , 每个循环计每个循环计195 195 次以产生次以产生0.05 0.05 秒秒
(50000 (50000 us)us) 中断中断
�� 每四个循环每四个循环 (0.2 (0.2 seconds) seconds) 触发触发LED 0.LED 0.

�� LED 0 (RB0)LED 0 (RB0)以此速率闪烁以此速率闪烁
�� 在改变在改变LEDLED状态前你要读它的当前状态状态前你要读它的当前状态, , 或采用其他方式或采用其他方式

�� 对该口写一完整的值对该口写一完整的值,,不对该口寄存器使用不对该口寄存器使用 bsf/bcfbsf/bcf指令指令

�� 使用使用 MPLAB SIM, MPLAB ICD2 MPLAB SIM, MPLAB ICD2 以及以及 PICDEM 2 PICDEM 2 
PlusPlus验证你的结果验证你的结果
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LAB 5第一部分LAB 5LAB 5第一部分第一部分

#INCLUDE p16F877A.inc ; Include the standard definitions
#INCLUDE 701PIC.inc ; Include MACROs from MASTER’s 03, PIC 102 class

ISRCtr EQU 0x30 ; location for ISRCtr variable (countdown for ISR loops)

ORG 0 ; Reset Vector Location (0)
Start 

goto Initialize ; On start-up go to Initialization code

ORG 4 ; 中断 Vector Location (4)
ISR

; Macro to context save in ISR
; Clear the TMR0 中断 condition
; Reload the Timer for accurate timing
; Decrement the ISRCounter (from 4 to 0) and test for 0
; if the counter is not yet 0, then toggling is not needed
; if the counter is 0, run toggle code

##INCLUDE p16F877A.incINCLUDE p16F877A.inc ; Include the standard definitions; Include the standard definitions
#INCLUDE 701PIC.inc#INCLUDE 701PIC.inc ; Include ; Include MACROsMACROs from from MASTERMASTER’’ss 03, PIC 102 class03, PIC 102 class

ISRCtrISRCtr EQUEQU 0x300x30 ; location for ; location for ISRCtrISRCtr variable (countdown for ISR loops)variable (countdown for ISR loops)

ORGORG 00 ; Reset Vector Location (0); Reset Vector Location (0)
Start Start 

gotogoto InitializeInitialize ; On start; On start--up go to Initialization codeup go to Initialization code

ORGORG 44 ; ; 中断中断 Vector Location (4)Vector Location (4)
ISRISR

; Macro to context save in ISR; Macro to context save in ISR
; Clear the TMR0 ; Clear the TMR0 中断中断 conditioncondition
; Reload the Timer for accurate timing; Reload the Timer for accurate timing
; Decrement the ; Decrement the ISRCounterISRCounter (from 4 to 0) and test for 0(from 4 to 0) and test for 0
; if the counter is not yet 0, then toggling is not needed; if the counter is not yet 0, then toggling is not needed
; if the counter is 0, run toggle code; if the counter is 0, run toggle code
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LAB 5 第二部分LAB 5LAB 5 第二部分第二部分

ToggleLED
; put 4 into W to reload into the
; 中断 counter (after 4 counts we need to reset it)

; write 1 to W in order to, 
;  toggle LED 0 of PORTB - XOR with 1 will toggle the bit

SkipToggle ; Done 中断, so restore and exit
; Macro to context restore when leaving ISR
; Return from 中断

ToggleLEDToggleLED
; put 4 into W to reload into the; put 4 into W to reload into the
; ; 中断中断 counter (after 4 counts we need to reset it)counter (after 4 counts we need to reset it)

; write 1 to W in order to, ; write 1 to W in order to, 
;  toggle LED 0 of PORTB ;  toggle LED 0 of PORTB -- XOR with 1 will toggle the bitXOR with 1 will toggle the bit

SkipToggleSkipToggle ; Done ; Done 中断中断, , so restore and exitso restore and exit
; Macro to context restore when leaving ISR; Macro to context restore when leaving ISR
; Return from ; Return from 中断中断
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LAB 5 第三部分LAB 5 LAB 5 第三部分第三部分

Initialize
; Ensure LED 0 is off
; MACRO to setup I/O port to drive LED RB0
; Write 4 to W to 
;  preload the ISR counter with
; Preload the timer for appropriate time delay
; Turn on GIE and
; TMR0 中断 (T0IE)
; Set up banking to access OPTION_REG in bank 1
; Set up TMR0 for 256 prescale and
;  internal clock mode 
; return to accessing BANK 0

goto $ ; Wait forever for 中断

InitializeInitialize
; Ensure LED 0 is off; Ensure LED 0 is off
; MACRO to setup I/O port to drive LED RB0; MACRO to setup I/O port to drive LED RB0
; Write 4 to W to ; Write 4 to W to 
;  preload the ISR counter with;  preload the ISR counter with
; Preload the timer for appropriate time delay; Preload the timer for appropriate time delay
; Turn on GIE and; Turn on GIE and
; TMR0 ; TMR0 中断中断 ((T0IE)T0IE)
; Set up banking to access OPTION_REG in bank 1; Set up banking to access OPTION_REG in bank 1
; Set up TMR0 for 256 ; Set up TMR0 for 256 prescaleprescale andand
;  internal clock mode ;  internal clock mode 
; return to accessing BANK 0; return to accessing BANK 0

gotogoto $$ ; Wait forever for ; Wait forever for 中断中断
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LAB 5 第四部分LAB 5 LAB 5 第四部分第四部分

; Subroutine to reload TMR0 
DoReloadTimer

; Preload Timer to 
;  count 195 times before roll-over
; return from subroutine

END

; ; Subroutine to reload TMR0 Subroutine to reload TMR0 
DoReloadTimerDoReloadTimer

; Preload Timer to ; Preload Timer to 
;  count 195 times before roll;  count 195 times before roll--overover
; return from subroutine; return from subroutine

ENDEND
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Lab 5 注意点Lab 5 Lab 5 注意点注意点

� 定时器:
� PIC 微控制器带预分频可选的至少 8位

(TMR0) 定时器

� 需要重装初值以得到期望时间

� 可以通过计几次溢出以得到期望时间.
� 中断:

� 判断是否是您应用中所要的中断,如果是

� 不要忘了保护和恢复现场

� 置GIE, 及其他 xxIE 位来打开中断

� 中断向量从程序段的0004h开始

�� 定时器定时器::
�� PIC PIC 微控制器带预分频可选的至少微控制器带预分频可选的至少 88位位

((TMR0) TMR0) 定时器定时器

�� 需要重装初值以得到期望时间需要重装初值以得到期望时间

�� 可以通过计几次溢出以得到期望时间可以通过计几次溢出以得到期望时间..
�� 中断中断::

�� 判断是否是您应用中所要的中断判断是否是您应用中所要的中断,,如果是如果是

�� 不要忘了保护和恢复现场不要忘了保护和恢复现场

�� 置置GIE, GIE, 及其他及其他 xxIExxIE 位来打开中断位来打开中断

�� 中断向量从程序段的中断向量从程序段的0004h0004h开始开始
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Lab 6
时间片系统

(实时多任务)

Lab 6Lab 6
时间片系统时间片系统

((实时多任务实时多任务))
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Lab6目标Lab6Lab6目标目标

� Lab6目标
� 简单的时间片系统(Time -Slicing Systems )
� 代码迅速处理两个 (或以上的) 任务!

�� Lab6Lab6目标目标
�� 简单的时间片系统简单的时间片系统(Time (Time --Slicing Systems )Slicing Systems )
�� 代码迅速处理两个代码迅速处理两个 ((或以上的或以上的) ) 任务任务!!
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Lab6: 任务Lab6: Lab6: 任务任务

� LED 0以0.15 秒点亮, 0.25 秒熄灭来闪烁 ,并且蜂鸣
器(及 LED 1闪烁) 以0.5秒打开, 1秒关闭:
� 让我们看看是什么现象:

�� LED 0LED 0以以0.15 0.15 秒点亮秒点亮, 0.25 , 0.25 秒熄灭来闪烁秒熄灭来闪烁 ,,并且蜂鸣并且蜂鸣
器器((及及 LED 1LED 1闪烁闪烁) ) 以以0.50.5秒打开秒打开, 1, 1秒关闭秒关闭::
�� 让我们看看是什么现象让我们看看是什么现象::

LEDLEDLED

PiezoPiezoPiezo

TimeTimeTime 000 0.50.50.5 111 1.51.51.5 222 2.52.52.5

. . .. . .. . .

. . .. . .. . .OnOnOn OffOffOff

OnOnOn OffOffOff OnOnOn OffOffOff OnOnOn OffOffOff OnOnOn OffOffOff OnOnOn OffOffOff OnOnOn OffOffOff OnOnOn OOO

OnOnOn OfOfOf
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Lab6: 计算Lab6: Lab6: 计算计算

� 分时
� 找出最小的时间单元:
� 秒数:  0.15, 0.25, 0.5, 1.0

� 0.05 秒贯穿所有这些整数时间段 (使用 GCF 
来计算)

� 计算任务数 (及变量):  2
� 然后生成一计划来显示这两个软件计数器是怎样

控制这些任务的.

�� 分时分时

�� 找出找出最小的时间单元最小的时间单元::
�� 秒数秒数:  :  0.15, 0.25, 0.5, 1.00.15, 0.25, 0.5, 1.0

�� 0.050.05 秒贯穿所有这些整数时间段秒贯穿所有这些整数时间段 ((使用使用 GCF GCF 
来计算来计算))

�� 计算计算任务数任务数 ((及变量及变量)):  :  22
�� 然后生成一计划来显示这两个软件计数器是怎样然后生成一计划来显示这两个软件计数器是怎样

控制这些任务的控制这些任务的..

Note:  GCF stands for “Greatest Common Factor”NoteNote:  GCF stands for :  GCF stands for ““Greatest Common FactorGreatest Common Factor””
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Lab6: 分时 (Animated)Lab6: Lab6: 分时分时 ((Animated)Animated)

TMR0 中断 每 0.05 s 在每个计数寄存器中产生一次计数

LEDCtr
((计数器计数器))0                                                               0                                                               00

PiezoCtr
计数器计数器))

LED LED 计数器计数器
0:  ON0:  ON
3:  OFF3:  OFF
8:  8:  复位到复位到 00

PiezoPiezo 计数器计数器
0:  ON0:  ON

10:  OFF10:  OFF
30:  30:  复位到复位到00

OFFOFFOFFONONONOFFOFFOFFONONON

1                                                               1                                                               112                                                               2                                                               223                                                               3                                                               334                                                               4                                                               445                                                               5                                                               556                                                               6                                                               667                                                               7                                                               770                                                               0                                                               881                                                               1                                                               992                                                               2                                                               10103                                                               3                                                               11114                                                               4                                                               12125 5 2929

6                                                               6                                                               00

OFFOFFOFFONONON OFFOFFOFFOFFOFFOFF ONONON
LEDLEDLED

PiezoPiezoPiezo
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Lab6: 计划Lab6: Lab6: 计划计划

� TMR0每0.05秒中断一次以产生时基

� 该时基用于:
� 点亮或熄灭 LED 0 及LED 1 (RB0 及 RB1)
� 打开或关闭 Piezo
� 清掉 LED 及 Piezo的时间计数器

� 点亮2个 LEDs 并使蜂鸣器发声 (以 500 Hz):
� RB0 打开时间 0.15 秒, 关闭时间 0.25 秒 (共0.4s)
� RB1 打开时间 0.5 秒, 关闭时间 1 秒 (共1.5 s) 
� Piezo 响 0.5 秒, 关闭1秒 (同 RB1)

� 使用宏指令来简化代码

�� TMR0TMR0每每0.050.05秒秒中断一次以产生时基中断一次以产生时基

�� 该时基用于该时基用于::
�� 点亮或熄灭点亮或熄灭 LED 0 LED 0 及及LED 1 (RB0 LED 1 (RB0 及及 RB1)RB1)
�� 打开或关闭打开或关闭 PiezoPiezo
�� 清掉清掉 LED LED 及及 PiezoPiezo的时间计数器的时间计数器

�� 点亮点亮22个个 LEDsLEDs 并使蜂鸣器发声并使蜂鸣器发声 ((以以 500 500 Hz):Hz):
�� RB0RB0 打开时间打开时间 0.15 0.15 秒秒, , 关闭时间关闭时间 0.25 0.25 秒秒 ((共共0.4s)0.4s)
�� RB1 RB1 打开时间打开时间 0.5 0.5 秒秒, , 关闭时间关闭时间 1 1 秒秒 ((共共1.5 1.5 s) s) 
�� PiezoPiezo 响响 0.5 0.5 秒秒, , 关闭关闭11秒秒 ((同同 RB1)RB1)

�� 使用宏指令来简化代码使用宏指令来简化代码
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Lab6第一部分Lab6Lab6第一部分第一部分

#INCLUDE p16F877A.inc ; Include the standard definitions
#INCLUDE 701PIC.inc ; Include MACROs from MASTER’s 03, PIC 102 class
#DEFINE DEVICE_FREQ_HZ D'4000000’ ; Needed by Piezo series macros

LEDCtr EQU 0x30 ; Counter for LED timing
PiezoCtr EQU 0x31 ; Counter for Piezo timing

ORG H'00' ; Reset Vector
Start

goto Initialize ; Jump to Initialization code

ORG H'04' ; 中断 Vector
ISR

; Macro to context save in ISR
; Clear the TMR0 中断 condition
; Add 1 to LEDCtr
; Add 1 to PiezoCtr
; Reload the Timer for accurate timing
; Macro to context restore when leaving ISR
; Return from 中断

##INCLUDE p16F877A.incINCLUDE p16F877A.inc ; Include the standard definitions; Include the standard definitions
#INCLUDE 701PIC.inc#INCLUDE 701PIC.inc ; Include ; Include MACROsMACROs from from MASTERMASTER’’ss 03, PIC 102 class03, PIC 102 class
#DEFINE DEVICE_FREQ_HZ D'4000000#DEFINE DEVICE_FREQ_HZ D'4000000’’ ; Needed by ; Needed by PiezoPiezo series macrosseries macros

LEDCtrLEDCtr EQUEQU 0x300x30 ; Counter for LED timing; Counter for LED timing
PiezoCtrPiezoCtr EQUEQU 0x310x31 ; Counter for ; Counter for PiezoPiezo timingtiming

ORGORG H'00'H'00' ; Reset Vector; Reset Vector
StartStart

gotogoto InitializeInitialize ; Jump to Initialization code; Jump to Initialization code

ORGORG H'04'H'04' ; ; 中断中断 VectorVector
ISRISR

; Macro to context save in ISR; Macro to context save in ISR
; Clear the TMR0 ; Clear the TMR0 中断中断 conditioncondition
; Add 1 to ; Add 1 to LEDCtrLEDCtr
; Add 1 to ; Add 1 to PiezoCtrPiezoCtr
; Reload the Timer for accurate timing; Reload the Timer for accurate timing
; Macro to context restore when leaving ISR; Macro to context restore when leaving ISR
; Return from ; Return from 中断中断
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Lab6第二部分Lab6Lab6第二部分第二部分

Initialize
LEDOff 0 ; Turn off both LEDs
LEDOff 1 ;  "
clrf LEDCtr ; Initialze Task Couters to 0

;  " (both LED and Piezo)
; MACRO to setup I/O port to drive LEDs RB1 and RB0
; 500 Hz Beep when PiezoOn is used
; Preload the timer for appropriate time delay
; set banking to access OPTION_REG in bank 1
; Set up TMR0 for 256 prescale and 
;  internal clock mode
; Return to accessing BANK 0

; Turn on GIE and TMR0 中断

;  "

InitializeInitialize
LEDOffLEDOff 00 ; Turn off both ; Turn off both LEDsLEDs
LEDOffLEDOff 11 ;  ";  "
clrfclrf LEDCtrLEDCtr ; ; InitialzeInitialze Task Task CoutersCouters to 0to 0

;  " (both LED and ;  " (both LED and PiezoPiezo))
; MACRO to setup I/O port to drive ; MACRO to setup I/O port to drive LEDsLEDs RB1 and RB0RB1 and RB0
; 500 Hz Beep when ; 500 Hz Beep when PiezoOnPiezoOn is usedis used
; Preload the timer for appropriate time delay; Preload the timer for appropriate time delay
; set banking to access OPTION_REG in bank 1; set banking to access OPTION_REG in bank 1
; Set up TMR0 for 256 ; Set up TMR0 for 256 prescaleprescale and and 
;  internal clock mode;  internal clock mode
; Return to accessing BANK 0; Return to accessing BANK 0

; Turn on GIE and TMR0 ; Turn on GIE and TMR0 中断中断

;  ";  "



© Microchip Technology Incorporated. All Rights Reserved.         701 PIC           701 PIC           PIC® MCU - Introduction to Programming          174

Lab6第三部分Lab6Lab6第三部分第三部分

LEDTest
; Test LED1 Counter Value for overflow
;  by subtracting 8 from it.  Leave result in W
; Test for 0 to determine if equal
; If counter is not 8, test if LED should be on or off
; If counter is 8, it is reset to 0

NotEqual1
; Test LED counter against "On" time
;  by subtracting 3 from it.  Leave result in W
; Test for negative value to determine if less than 3
; if 3 or more, goto LEDOff Code

TurnOnLED
; else, Turn on LED 0 since counter is less than 3 
; LED Testing done, goto PiezoTest

TurnOffLED
; Turn off LED since counter is 3 or more (up to 7)
; LED Testing now done, so fall into PiezoTest

LEDTestLEDTest
; Test LED1 Counter Value for overflow; Test LED1 Counter Value for overflow
;  by subtracting 8 from it.  Leave result in W;  by subtracting 8 from it.  Leave result in W
; Test for 0 to determine if equal; Test for 0 to determine if equal
; If counter is not 8, test if LED should be on or off; If counter is not 8, test if LED should be on or off
; If counter is 8, it is reset to 0; If counter is 8, it is reset to 0

NotEqual1NotEqual1
; Test LED counter against "On" time; Test LED counter against "On" time
;  by subtracting 3 from it.  Leave result in W;  by subtracting 3 from it.  Leave result in W
; Test for negative value to determine if less than 3; Test for negative value to determine if less than 3
; if 3 or more, ; if 3 or more, gotogoto LEDOffLEDOff CodeCode

TurnOnLEDTurnOnLED
; else, Turn on LED 0 since counter is less than 3 ; else, Turn on LED 0 since counter is less than 3 
; LED Testing done, ; LED Testing done, gotogoto PiezoTestPiezoTest

TurnOffLEDTurnOffLED
; Turn off LED since counter is 3 or more (up to 7); Turn off LED since counter is 3 or more (up to 7)
; LED Testing now done, so fall into ; LED Testing now done, so fall into PiezoTestPiezoTest
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Lab6第四部分Lab6Lab6第四部分第四部分

PiezoTest
; Test Piezo Counter Value
;  by subtracting 30 from it.  Leave result in W
; Test for 0 to determine if equal
; If counter is not 30, test if LED should be on or off
; If counter is 30, it is reset to 0

NotEqual2
; Test Piezo Counter against "On" time
;  by subtracting 10 from it.  Leave result in W
; Test for negative value to determine if less than 3
; if 10 or more, goto LEDOff Code

TurnOnPiezo
; Turn on LED1
; Turn on Piezo (by turning on CCP1)
; manage tasks by returning to top of list

TurnOffPiezo
; Turn off LED1
; Turn off Piezo (by turning off CCP1)

goto LEDTest ; manage tasks by returning to top of list

PiezoTestPiezoTest
; Test ; Test PiezoPiezo Counter ValueCounter Value
;  by subtracting 30 from it.  Leave result in W;  by subtracting 30 from it.  Leave result in W
; Test for 0 to determine if equal; Test for 0 to determine if equal
; If counter is not 30, test if LED should be on or off; If counter is not 30, test if LED should be on or off
; If counter is 30, it is reset to 0; If counter is 30, it is reset to 0

NotEqual2NotEqual2
; Test ; Test PiezoPiezo Counter against "On" timeCounter against "On" time
;  by subtracting 10 from it.  Leave result in W;  by subtracting 10 from it.  Leave result in W
; Test for negative value to determine if less than 3; Test for negative value to determine if less than 3
; if 10 or more, ; if 10 or more, gotogoto LEDOffLEDOff CodeCode

TurnOnPiezoTurnOnPiezo
; Turn on LED1; Turn on LED1
; Turn on ; Turn on PiezoPiezo (by turning on CCP1)(by turning on CCP1)
; manage tasks by returning to top of list; manage tasks by returning to top of list

TurnOffPiezoTurnOffPiezo
; Turn off LED1; Turn off LED1
; Turn off ; Turn off PiezoPiezo (by turning off CCP1)(by turning off CCP1)

gotogoto LEDTestLEDTest ; manage tasks by returning to top of list; manage tasks by returning to top of list
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Lab6第五部分Lab6Lab6第五部分第五部分

; Subroutine to reload TMR0
DoReloadTimer

; Preload Timer to 
; count 195 times before roll-over
; return from subroutine

END

; ; Subroutine to reload TMR0Subroutine to reload TMR0
DoReloadTimerDoReloadTimer

; Preload Timer to ; Preload Timer to 
; count 195 times before roll; count 195 times before roll--overover
; return from subroutine; return from subroutine

ENDEND
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对您项目的

帮助
对您项目的对您项目的

帮助帮助
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Microchip 应用支持Microchip Microchip 应用支持应用支持

www.microchip.com
数据手册, 应用笔记, 设计中心

申请免费样片
选择最好的元件
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Microchip 应用支持Microchip Microchip 应用支持应用支持

China.techhelp@microchip.co
m

800-820-6247 

China.techhelp@microchip.coChina.techhelp@microchip.co
mm

800800--820820--6247 6247 

仍有困难?
免费的电话或e-mail帮助!

800-820-6247800800--820820--62476247

Development Systems 
Information Line

Development Systems Development Systems 
Information LineInformation Line
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附录附录附录
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使用模板来建立文件使用模板来建立文件使用模板来建立文件

� 模板能帮助您快速建立文件

� File -> Open  
� 进入模板路径:

� 找到您所需的文件 – 文件名中带
有芯片型号的后几位字符

� 举例如 PIC12F675 或 (‘F675), 
文件名 是f675temp.asm

�� 模板能帮助您快速建立文件模板能帮助您快速建立文件

�� File File --> Open  > Open  
�� 进入模板路径进入模板路径::

�� 找到您所需的文件找到您所需的文件 –– 文件名中带文件名中带
有芯片型号的后几位字符有芯片型号的后几位字符

�� 举例如举例如 PIC12F675PIC12F675 或或 ((‘‘F675F675), ), 
文件名文件名 是是f675temp.asmf675temp.asm

C:\Program Files\MPLAB IDE\C:C:\\Program FilesProgram Files\\MPLAB IDEMPLAB IDE\\
MCHIP_Tools\模板\CODEMCHIP_ToolsMCHIP_Tools\\模板模板\\CODECODE
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模板中有些什么?模板中有些什么模板中有些什么??

� 说明
� 代码编写提示

� 文件信息
� 文件名,时间, 版本等

� 所需的文件
� 说明项目中所用到的其他文

件

�� 说明说明

�� 代码编写提示代码编写提示

�� 文件信息文件信息
�� 文件名文件名,,时间时间, , 版本等版本等

�� 所需的文件所需的文件

�� 说明项目中所用到的其他文说明项目中所用到的其他文
件件

芯片名
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模板中有些什么?模板中有些什么模板中有些什么??

� 笔记
� 解释程序流程

� Include, List 及
_ _CONFIG 指令

� Includes 标准定义

� 设定配置位

� 定义变量
� EQU 定义变量

� 中断 中用的临时变量已有
定义

�� 笔记笔记

�� 解释程序流程解释程序流程

�� Include, List Include, List 及及
_ __ _CONFIG CONFIG 指令指令

�� Includes Includes 标准定义标准定义

�� 设定配置位设定配置位

�� 定义变量定义变量
�� EQU EQU 定义变量定义变量

�� 中断中断 中用的临时变量已有中用的临时变量已有
定义定义
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模板中有些什么?模板中有些什么模板中有些什么??
� 向量

� 复位, 中断 向量及代码

� 中断 保护及恢复

� 在中断保护代码及恢复寄
存器

� 用户代码
� 您的代码 从这里开始

� EEPROM 初始化

� END 指令

�� 向量向量
�� 复位复位, , 中断中断 向量及代码向量及代码

�� 中断中断 保护及恢复保护及恢复

�� 在中断保护代码及恢复寄在中断保护代码及恢复寄
存器存器

�� 用户代码用户代码
�� 您的代码您的代码 从这里开始从这里开始

�� EEPROM EEPROM 初始化初始化

�� END END 指令指令
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外设:
PortB输入中断

外设外设::
PortBPortB输入中断输入中断

� 内部上拉(软件实现) 使
RB4-RB7 脚为高

� RB0-RB3 脚输出 ‘0’

� 按下任何建将使 RB 脚
拉低并产生一中断

� 该中断能使处理器从
SLEEP模式唤醒

� 节省了定时器资源

�� 内部上拉内部上拉((软件实现软件实现) ) 使使
RB4RB4--RB7 RB7 脚为高脚为高

�� RB0RB0--RB3 RB3 脚输出脚输出 ‘‘00’’

�� 按下任何建将使按下任何建将使 RB RB 脚脚
拉低并产生一中断拉低并产生一中断

�� 该中断能使处理器从该中断能使处理器从
SLEEPSLEEP模式唤醒模式唤醒

�� 节省了定时器资源节省了定时器资源

键盘接口:键盘接口:

PIC16CXXX

RB0
RB1

RB3

RB4
RB5

RB6
RB7

RB2

Hex keypad

R R ††

† Resistance for ESD protection† Resistance for ESD protection

100 100 　　

AN557
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可靠性设计技术
硬件看门狗

可靠性设计技术可靠性设计技术
硬件看门狗硬件看门狗

� 有助于从软件故障中唤醒

� 使用芯片自带的 RC振荡

� WDT 不能由软件关掉

� WDT 溢出时使芯片复位

� CLRWDT 指令清 WDT
� 可编程的溢出周期: 18 ms 到 2.5 秒
� SLEEP模式时也工作

� 在 溢出时 唤醒 CPU

�� 有助于从软件故障中唤醒有助于从软件故障中唤醒

�� 使用芯片自带的使用芯片自带的 RCRC振荡振荡

�� WDT WDT 不能由软件关掉不能由软件关掉

�� WDT WDT 溢出时使芯片复位溢出时使芯片复位

�� CLRWDT CLRWDT 指令清指令清 WDTWDT
�� 可编程的溢出周期可编程的溢出周期: 18 : 18 ms ms 到到 2.5 2.5 秒秒
�� SLEEPSLEEP模式时也工作模式时也工作

�� 在在 溢出时溢出时 唤醒唤醒 CPUCPU

8-bit ripple counter

""CLRWDT"CLRWDT"

ResetReset OverflowOverflow
resetsresets
chipchip

PostscalerRC
oscillator
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可靠性设计技术
软件看门狗

可靠性设计技术可靠性设计技术
软件看门狗软件看门狗

� 只用软件控制，看门狗 同样有效

� 整个程序中只使用 一个 CLRWDT 指令

� 将 CLRWDT 指令放在主循环中

� 不要将 CLRWDT指令放在 ISR 或其他子程序
中

� 选择主循环能容许的最小WDT 溢出周期

� 以GOTO wdtreset指令 (自循环) 初始化不用
的内存来强制溢出

�� 只用软件控制，看门狗只用软件控制，看门狗 同样有效同样有效

�� 整个程序中只使用整个程序中只使用 一个一个 CLRWDT CLRWDT 指令指令

�� 将将 CLRWDT CLRWDT 指令放在主循环中指令放在主循环中

�� 不要将不要将 CLRWDTCLRWDT指令放在指令放在 ISR ISR 或其他子程序或其他子程序
中中

�� 选择主循环能容许的最小选择主循环能容许的最小WDT WDT 溢出周期溢出周期

�� 以以GOTO GOTO wdtresetwdtreset指令指令 ((自循环自循环) ) 初始化不用初始化不用
的内存来强制溢出的内存来强制溢出
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可靠性设计技术
填充未用的程序空间
可靠性设计技术可靠性设计技术

填充未用的程序空间填充未用的程序空间

� 当使用看门狗时, 未用的区域填充GOTO wdtreset指
令

� 该自循环正常情况不会执行

� 如果 PC 工作失常, 就很有可能会执行这条指令
� 通过 WDT 强制复位来初始化内核

� 在插入该指令时可使用FILL
(假设<最末程序地址+1>是 400h):

� FILL (GOTO wdtreset), (400h-$)
� ORG 3FFh

�� 当使用看门狗时当使用看门狗时, , 未用的区域填充未用的区域填充GOTO GOTO wdtresetwdtreset指指
令令

�� 该自循环正常情况不会执行该自循环正常情况不会执行

�� 如果如果 PC PC 工作失常工作失常, , 就很有可能会执行这条指令就很有可能会执行这条指令
�� 通过通过 WDT WDT 强制复位来初始化内核强制复位来初始化内核

�� 在插入该指令时可使用在插入该指令时可使用FILLFILL
((假设假设<<最末程序地址最末程序地址+1>+1>是是 400h):400h):

�� FILLFILL (GOTO(GOTO wdtresetwdtreset), (400h), (400h--$)$)
�� ORG 3FFhORG 3FFh
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可靠性设计技术
干净的 WDT 复位
可靠性设计技术可靠性设计技术
干净的干净的 WDT WDT 复位复位

� 上电时强制 WDT 复位:
� 上电时检查 RAM模式

� 如果模式不正确:
� 初始化 RAM模式

� 强制 WDT复位

� 如果代码跳到未用的程序区强制WDT复位

�� 上电时强制上电时强制 WDT WDT 复位复位::
�� 上电时检查上电时检查 RAMRAM模式模式

�� 如果模式不正确如果模式不正确::
�� 初始化初始化 RAMRAM模式模式

�� 强制强制 WDTWDT复位复位

�� 如果代码跳到未用的程序区强制如果代码跳到未用的程序区强制WDTWDT复位复位
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可靠性设计技术
子程序计数

可靠性设计技术可靠性设计技术
子程序计数子程序计数

� 设定子程序调用计数器及子程序执行计数器

� 每调用一次子程序，子程序调用计数器自增1
� 在每个子程序开始使执行计数器自增1
� 在主循环开始, 检查调用计数器和执行计数器是否相

等

� 如果不等，强制 WDT 复位

�� 设定子程序调用计数器及子程序执行计数器设定子程序调用计数器及子程序执行计数器

�� 每调用一次子程序，子程序调用计数器自增每调用一次子程序，子程序调用计数器自增11
�� 在每个子程序开始使执行计数器自增在每个子程序开始使执行计数器自增11
�� 在主循环开始在主循环开始, , 检查调用计数器和执行计数器是否相检查调用计数器和执行计数器是否相

等等

�� 如果不等，强制如果不等，强制 WDT WDT 复位复位
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术语表术语表术语表

� TMR0 - 8-bit timer peripheral 
w/8 bit 预分频

� 预分频 - peripheral which delays 
the TMR0 count by a prescale
ratio i.e. 1:1, 1:2, 1:4

� Page - memory organization for 
program memory

� Bank - memory organization for 
data memory

� Pipeline - hardware architecture 
for prefetching an opcode while 
executing the previous opcode

� Orthogonal instruction set -
instructions work on ports and 
registers the same way

�� TMR0 TMR0 -- 88--bit timer peripheral bit timer peripheral 
w/8 bit w/8 bit 预分频预分频

�� 预分频预分频 -- peripheral which delays peripheral which delays 
the TMR0 count by a the TMR0 count by a prescaleprescale
ratio i.e. 1:1, 1:2, 1:4ratio i.e. 1:1, 1:2, 1:4

�� Page Page -- memory organization for memory organization for 
program memoryprogram memory

�� Bank Bank -- memory organization for memory organization for 
data memorydata memory

�� Pipeline Pipeline -- hardware architecture hardware architecture 
for for prefetchingprefetching an an opcodeopcode while while 
executing the previous executing the previous opcodeopcode

�� Orthogonal instruction set Orthogonal instruction set --
instructions work on ports and instructions work on ports and 
registers the same wayregisters the same way

� OPTION_REG - 寄存器of control 
bits for configuring tmr0, INT, and 
pull ups

� INTCON - 寄存器of control bits 
for configuring peripheral 中断

� STATUS - 寄存器of bits indicating 
the results of an operation

� RP1&RP0 - direct addressing 
bank selection control bits

� IRP - indirect addressing bank 
selection control bit

� PORTB - I/O port B
� GPIO - I/O port on the 8 pin parts

�� OPTION_REG OPTION_REG -- 寄存器寄存器of control of control 
bits for configuring tmr0, INT, and bits for configuring tmr0, INT, and 
pull upspull ups

�� INTCON INTCON -- 寄存器寄存器of control bits of control bits 
for configuring peripheral for configuring peripheral 中断中断

�� STATUS STATUS -- 寄存器寄存器of bits indicating of bits indicating 
the results of an operationthe results of an operation

�� RP1&RP0 RP1&RP0 -- direct addressing direct addressing 
bank selection control bitsbank selection control bits

�� IRP IRP -- indirect addressing bank indirect addressing bank 
selection control bitselection control bit

�� PORTB PORTB -- I/O port BI/O port B
�� GPIO GPIO -- I/O port on the 8 pin partsI/O port on the 8 pin parts
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Lab 1
Projects the Old Way

Lab 1Lab 1
Projects the Old WayProjects the Old Way

� 使用Configure > Select Device 来
选择处理器

� 注意有不同的开发工具来支持

� 使用最新的 MPLAB IDE 确保得到最
好支持

�� 使用使用Configure > Select DeviceConfigure > Select Device 来来
选择处理器选择处理器

�� 注意有不同的开发工具来支持注意有不同的开发工具来支持

�� 使用最新的使用最新的 MPLAB IDE MPLAB IDE 确保得到最确保得到最
好支持好支持



© Microchip Technology Incorporated. All Rights Reserved.         701 PIC           701 PIC           PIC® MCU - Introduction to Programming          194

Lab 1
项目建立

Lab 1Lab 1
项目建立项目建立

� 点击 File > New 产生新的
项目文件.

� 也可以通过 File > Open 打
开文件完成此操作.

� 可以在此处保存workspace 
以及 import 和 export 文件
供后面使用.  

�� 点击点击 File > NewFile > New 产生新的产生新的
项目文件项目文件..

�� 也可以通过也可以通过 File > OpenFile > Open 打打
开文件完成此操作开文件完成此操作..

�� 可以在此处保存可以在此处保存workspace workspace 
以及以及 import import 和和 export export 文件文件
供后面使用供后面使用.  .  
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Lab 1
项目建立

Lab 1Lab 1
项目建立项目建立

� 点击 Project > New 
Project 在 Workspace
中建立新的项目文件

� 输入项目名及 路径

�� 点击点击 Project > New Project > New 
ProjectProject 在在 WorkspaceWorkspace
中建立新的项目文件中建立新的项目文件

�� 输入项目名及输入项目名及 路径路径
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Lab 注意点: 
读-修改-写

Lab Lab 注意点注意点: : 
读读--修改修改--写写

PC PC + 1 PC + 2 PC + 3

Q1 Q2 Q3 Q4 Q1 Q2 Q3 Q4 Q1 Q2 Q3 Q4 Q1 Q2 Q3 Q4

Instruction
fetched

RB7:RB0

MOVWF PORTB
write to
PORTB

NOP

Port pin
sampled here

NOP
MOVF PORTB,W

Instruction
executed

MOVWF PORTB
write to
PORTB

NOP
MOVF PORTB,W

PC

TPD

注意:

本例显示对 PORTB一次写指令后
紧跟一条读指令.

注意到:
数据建立时间 = (0. 25TCY-TPD )

这里 TCY= 指令周期

TPD = 传播延时

因此, 在较高时钟频率时,
写操作后紧跟读操作可能会出现问题.

� 在反复读写口时要考虑口的负载

� Qcy = Fosc
� Instruction cycle = Fosc/4
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按钮/按键去抖或噪声输入按钮按钮//按键去抖或噪声输入按键去抖或噪声输入

AN 566 contains debounce

Check_key
;poll for key press

btfsc PORTB,1 ;
goto Check_key ;

; call Debounce_delay ;debounce signal
btfsc PORTB,1 ;check for bouncing input
goto Check_key ;
return

; Routine to give delay for key bounce routine
Debounce_delay

.

.
delay routine here
.
return
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Exercise #1:  
启动 PICkitTM 1 软件

Exercise #1:  Exercise #1:  
启动启动 PICkitPICkitTMTM 1 1 软件软件

� Step 1: 启动软件

� Start->Programs-> PICkit™ 1 FLASH Start Kit-
> PICkit™ 1 FLASH Starter Kit

�� Step 1: Step 1: 启动软件启动软件

�� StartStart-->Programs>Programs--> > PICkitPICkit™™ 1 FLASH Start Kit1 FLASH Start Kit--
> > PICkitPICkit™™ 1 FLASH Starter Kit1 FLASH Starter Kit
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装载 Exercise1.hex 到缓冲装载装载 Exercise1.hex Exercise1.hex 到缓冲到缓冲

� Step 2:
� 找到 Exercise1.hex 

并装入缓冲

� File->Import HEX
� E:/PICkit1/Exercise/
� C:/Program Files/Microchip/PICkit1/Exercise/

�� Step 2:Step 2:
�� 找到找到 Exercise1.hex Exercise1.hex 

并装入缓冲并装入缓冲

�� FileFile-->Import HEX>Import HEX
�� E:/PICkit1/Exercise/E:/PICkit1/Exercise/
�� C:/Program Files/Microchip/PICkit1/Exercise/C:/Program Files/Microchip/PICkit1/Exercise/
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Exercise1:   成功写入Exercise1:   Exercise1:   成功写入成功写入

� Step 4:  状态窗口

� 成功写入

� Step 5: 成功装载后观察
PICkitTM 1
� LED D0 应以200ms的

速度闪烁

�� Step 4:  Step 4:  状态窗口状态窗口

�� 成功写入成功写入

�� Step 5: Step 5: 成功装载后观察成功装载后观察
PICkitPICkitTMTM 11
�� LED LED D0D0 应以应以200200msms的的

速度闪烁速度闪烁

Write Successful
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Data Bus

Write Port

D

Q

Q
SET

CLR

D

Q

Q
SET

CLR

W Reg

Tris f

Read Port

I/O Pin
Data Latch

Tris Latch

Vss

VDD

Reset

外设:
数字I/O框图

外设外设::
数字数字I/OI/O框图框图


